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Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your

safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy

place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-

able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-

ating the machine.

Notes

Some illustrations in this manual might be slightly different from the machine.

Certain options might not be available in some countries. For details, please contact your local dealer.

Software Version Conventions Used in This Manual

• NetWare 3.x means NetWare 3.12 and 3.2.

• NetWare 4.x means NetWare 4.1, 4.11, 4.2 and IntranetWare.
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Manuals for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

Important

❒ Media differ according to manual.

❒ The printed and electronic versions of a manual have the same contents.

❒ Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

❒ Depending on which country you are in, there may also be html manuals. To
view these manuals, a Web browser must be installed.

❖ About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

❖ General Settings Guide
Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

❖ Troubleshooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

❖ Security Reference
This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered
with, or prevent the machine from unauthorized use.
Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

❖ Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

❖ Facsimile Reference
Explains Facsimile functions and operations.

❖ Printer Reference
Explains Printer functions and operations.

❖ Scanner Reference
Explains Scanner functions and operations.
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❖ Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.

❖ Other manuals

• Manuals for This Machine

• Safety Information

• Quick Reference Copy Guide

• Quick Reference Fax Guide

• Quick Reference Printer Guide

• Quick Reference Scanner Guide

• PostScript 3 Supplement

• UNIX Supplement

• Manuals for DeskTopBinder Lite

• DeskTopBinder Lite Setup Guide

• DeskTopBinder Introduction Guide

• Auto Document Link Guide

Note

❒ Manuals provided are specific to machine types.

❒ For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

❒ “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the
machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[ ]

Indicates the names of keys that appear on the machine’s display panel.

{ }

Indicates the names of keys on the machine’s control panel.
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Setting Up the Machine on a Network

This section describes the network settings you can change with User Tools (Sys-
tem Settings). Make settings according to functions you want to use and the in-
terface to be connected.

Important

❒ These settings should be made by the systems administrator, or after consult-
ing with the systems administrator.

Initial Settings Overview

❖ Interface Settings

❖ Network

Menu Description

Machine IPv4 Address Specifies the machine IPv4 address and sub-
net mask in the network environment.

IPv4 Gateway Address Configure the gateway address for the router 
or host computer used as a gateway.

Machine IPv6 Address Specifies the machine IPv6 address and sub-
net mask in the network environment.

IPv6 Gateway Address Configure the gateway address for the router 
or host computer used as a gateway.

IPv6 Stateless Setting Specifies the automatic configuration of the 
IPv6 Stateless Address. 

DNS Configuration Make settings for the DNS server.

DDNS Configuration Specifies the DDNS settings.

Domain Name Specifies the domain name.

WINS Configuration Specifies the WINS server settings.

Effective Protocol Select the protocol to use in the network.

NCP Delivery Protocol Select the protocol for NCP delivery:

NW Frame Type Select the frame type when you use NetWare.

SMB Computer Name Specifies the SMB computer name.

SMB Work Group Specifies the SMB work group.

Ethernet Speed Set the access speed for networks.

LAN Type Select interface, IEEE 802.11b (wireless LAN) 
or Ethernet when you have installed the op-
tional IEEE 802.11b interface unit.

Ping Command Check the network connection with ping 
command using given IP address.

Permit SNMPv3 Communictn. Set the encrypted communication of SNMP v3.
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❖ IEEE 802.11b

❖ File Transfer

Permit SSL/TLS Comm. Set the encrypted communication of 
SSL/TLS.

Host Name Specify the host name.

Machine Name Specify the machine name.

Menu Description

Communication Mode Specifies the communication mode of the 
wireless LAN.

SSID Setting Specifies SSID to distinguish the access point 
in infrastructure mode or 802.11 ad hoc mode.

Channel Specifies a channel when you select 802.11b 
ad hoc mode or ad hoc mode.

Security Type Specifies the encryption of the IEEE 802.11b 
(wireless LAN). 

Wireless LAN Signal Displays the status of the wireless LAN con-
nection between the machine and the access 
point when the machine is in Infrastructure 
mode.

Communication Speed Specifies the communication speed of the 
IEEE 802.11b (wireless LAN).

Restore Defaults Return the IEEE 802.11b (wireless LAN) set-
tings to their defaults.

Menu Description

Delivery Option Enables or disables sending scanned docu-
ments via the ScanRouter delivery software 
delivery server.

SMTP Server Specifies the SMTP server name.

SMTP Authentication Configures SMTP authentication (PLAIN, 
LOGIN, CRAM-MD5, DIGEST-MD5

POP before SMTP Configures POP authentication (POP before 
SMTP).

Reception Protocol Specifies Reception Protocol for receiving 
Internet faxes.

POP3/IMAP4 Settings Specify the POP3 or IMAP4 server name for 
receiving Internet faxes.

Admin. E-mail Address This appears as the sender’s address on e-
mailed scanned documents, if the sender is 
not specified .

E-mail Communication Port Specifies the POP3, IMAP4, and SMTP port 
numbers for receiving Internet faxes.

E-mail Recept. Interval Specify, in minutes, the time limit for receiv-
ing Internet faxes via POP3 or IMAP4 server.

Menu Description
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Initial Settings

❖ Printer/LAN-Fax (IPv6 cannot be used on LAN-Fax.)

Max. Recept. E-mail Size Specifies the Max. Reception E-mail Size for 
receiving Internet faxes.

E-mail Storage in Server Specifies whether or not to store received In-
ternet fax e-mails on the POP3 or IMAP4 
server.

Default User Name/PW(Send) Specifies the user name and password re-
quired when sending scan file directly to a 
shared folder on a computer running Win-
dows, or to an FTP server.

Auto Specify Sender Name Set name of the sender when sending an e-
mail.

Fax E-mail Account Specify [E-mail Address], [User Name], and 
[Password] for receiving Internet faxes.

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Setting

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Machine Name

Menu Description
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

Machine IPv6 Address

IPv6 Gateway Address

IPv6 Stateless Setting

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

NW Frame Type

SMB Computer Name

SMB Work Group

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Machine Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

Interface Settings
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❖ Internet Fax (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer Delivery Option

SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3/IMAP4 Settings

Admin. E-mail Address

E-mail Communication Port

E-mail Recept. Interval

Max. Recept. E-mail Size

E-mail Storage in Server

Default User Name/PW(Send)

Fax E-mail Account
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

WINS Configuration

DDNS Configuration

Domain Name

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3/IMAP4 Settings

Admin. E-mail Address

E-mail Communication Port

E-mail Recept. Interval

Max. Recept. E-mail Size

E-mail Storage in Server

Fax E-mail Account

Interface Settings
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❖ IP-Fax (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

WINS Configuration

DDNS Configuration

Domain Name

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed
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❖ E-mail (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

POP3/IMAP4 Settings

Admin. E-mail Address

E-mail Communication Port
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IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer SMTP Server

SMTP Authentication

POP before SMTP

Reception Protocol

Admin. E-mail Address

E-mail Communication Port

Interface Settings
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❖ Scan to Folder (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer Default User Name/PW(Send)

IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer Default User Name/PW(Send)



12

❖ Network Delivery Scanner (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Delivery Option

Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

File Transfer Delivery Option

IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed

File Transfer Delivery Option
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❖ Network TWAIN Scanner (IPv6 cannot be used on this function.)

Interface Settings

Ethernet Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

IEEE 802.11b 
(wireless LAN)

Interface Settings/Network Machine IPv4 Address

IPv4 Gateway Address

DNS Configuration

DDNS Configuration

Domain Name

WINS Configuration

Effective Protocol

NCP Delivery Protocol

Ethernet Speed

LAN Type

Permit SNMPv3 Communictn.

Permit SSL/TLS Comm.

Host Name

Interface Settings/
IEEE 802.11b

Communication Mode

SSID Setting

Channel

Security Type

Communication Speed



14

Note

❒ Depending on which optional units you have installed or the printer lan-
guage you have selected, some options are not displayed.

❒ Depending on the security settings, you might not be able to set certain op-
tions.

Reference

For details, see “System Settings”, General Settings Guide.

For details about copier features and system settings, see Copy Reference and
General Settings Guide.
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1. Using a Printer Server

Preparing Printer Server

This section explains how to configure the machine as a Windows network
printer. The machine is configured to enabling network clients to use it. When
the network printer is connected via SmartDeviceMonitor for Client, you can set
the printing notification function to notify clients of the results of their print jobs.

Important

❒ Under Windows 2000, Windows XP Professional, or Windows Server 2003, to
change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

❒ Although the machine’s print server supports computers running Windows
Vista, SmartDeviceMonitor for Client cannot be installed on computers run-
ning Windows Vista.

A Open the [Printers] window from the [Start] menu.

The [Printers] window appears.

Under Windows XP or Windows Server 2003, [Printer and Fax] window ap-
pears.

B Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

C On the [Sharing] tab, click [Shared As: ].

D To share the machine with users using a different version of Windows,
click [Additional Drivers...].

If you have installed an alternative driver by selecting [Share As: ] during the
printer driver installation, this step can be ignored.

E Click [OK], and then close the printer properties.
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Printing notification via SmartDeviceMonitor for Client

Follow the procedure below to configure the machine to use the printing notifi-
cation function of SmartDeviceMonitor for Client.

Setting the print server

Important

❒ Under Windows 2000, Windows XP Professional, or Windows Server 2003, to
change printer properties in the [Printer] folder, you need Printer Manage-
ment access authentication; under Windows NT 4.0, Full Control access au-
thentication. Log on to the file server as an Administrator or member of the
PowerUsers group.

A On the [Start] menu, point to [Programs], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Print Server Setting].

The print server setting dialog box appears.

B Select the [Notify client PCs of printout/data-transmission] check box, and then
click [OK].

After print server setting is made, a dialog box appears. Confirm the dialog
box content, and click [OK].

Click [Cancel] to interrupt the procedure.

A dialog box appears for client setting. 

C Click [OK].

The print server setting is completed. Each client must be set to receive print
notification.

Note

❒ Current printing jobs restart from the beginning after the spooler pauses
briefly.

❒ When the expansion function is not used, the function is automatically set
as available.

❒ If you log on using an account that does not have Administrator privileges,
the client may not be notified.
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Setting a Client

A On the [Start] menu, point to [Program], [DeskTopBinder], [SmartDeviceMonitor
for Client], and then click [Extended Features Settings].

A dialog box for setting the expansion function appears.

B Select the [Notify of printout/data-transmission when using print server] check box.

C Click [OK].

 The client setting is completed.

Note

❒ Set the printing notification function on the printer driver as well as on
SmartDeviceMonitor for Client.
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Using NetWare

This section describes the setting procedure for network printers in the NetWare
environment. In the NetWare environment, you can connect the machine as a
“print server” or “remote printer”.

Important

❒ IPv6 cannot be used on this function.

❖ Setting procedure

• When using the machine as a print server

A Installing SmartDeviceMonitor for Admin.

B Setting the network interface board.

C Turning the machine off and then back on.

•  When using the machine as a remote printer

A Installing SmartDeviceMonitor for Admin.

B Setting the network interface board. 

C Setting NetWare.

D Starting the print server.

Note

❒ This procedure assumes an environment is already prepared for normal Net-
Ware running the printing service setting.

❒ The procedure is explained with the following example settings:

• File server’s name …CAREE

• Print server’s name …PSERV

• Printer’s name …R-PRN

• Queue name …R-QUEUE

❖ Using SmartDeviceMonitor for Admin
To use the machine in a NetWare environment, use SmartDeviceMonitor for
Admin to set the NetWare printing environment. 

Note

❒ The NetWare Client provided by Novell is required to set the printing en-
vironment using SmartDeviceMonitor for Admin under the following en-
vironments:

• NDS mode in Windows 95/98/Me

• NDS or Bindery mode in Windows 2000/XP, Windows NT 4.0

Reference

p.37 “Installing SmartDeviceMonitor for Admin”
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❖ Printers listed by SmartDeviceMonitor for Admin
SmartDeviceMonitor for Admin lists printers connected to the network. If
you cannot identify the machine you want to configure, print configuration
page, and then check the machine name.

Setting Up as a Print Server (NetWare 3.x)

Follow the procedure below to connect the machine as a print server using Net-
Ware 3.x.

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Wizard], and then click [OK].

D Select the printer you want to configure, and then click [Next].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E Click [Login].

A dialog box for entering the login user name and password appears.

F Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

G Click [Configuration] in the left area, and then click [NetWare].

• Print Server Name: Enter the NetWare print server name. To use the inter-
face board as a print server, enter the name of a print server that is not ac-
tive on the file server. Use up to 47 characters.

• Logon Mode: Specify whether to designate a file server or NDS tree when
logging on to NetWare.

• File Server Name: When a file server name is entered here, only the speci-
fied file server is searched for. This item is mandatory. Use up to 47 char-
acters.

• NDS Tree: To enable NDS mode, enter the name of the NDS tree you want
to log on to. Use up to 32 alphanumeric characters.

• NDS Context Name: To enable NDS mode, enter the print server context.
Use up to 127 characters.

• Operation Mode: Specify whether to use the interface board as a print serv-
er or a remote printer.

• Remote Printer No.: This item is effective when the interface board is spec-
ified as a remote printer. Enter the same number as the number of the
printer to be created on the print server (0 to 254 characters).
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• Job Timeout: When the interface board is used as a NetWare remote print-
er, the printer cannot detect when a print job ends. Therefore, the printer
terminates printing when a certain period of time has elapsed since it last
received print data (i.e., when it has not received print data for a certain pe-
riod of time). Specify here this period of time (3 to 255 seconds). The initial
value is 15 (seconds).

• Frame Type: Select the frame type from the drop-down menu.

• Print Server Protocol: Select the protocol for NetWare from the drop-down
menu.

• NCP Delivery Protocol: Select the protocol for NCP delivery.

H Confirm the settings, and then click [OK].

Configuration is now complete. Wait several before restarting Web Image
Monitor.

I Click [Logout].

Note

❒ To check the configuration is correct, enter the following from the com-
mand prompt:

F:> USERLIST

❒ If the printer works as configured, the name of the print server appears as
a connected user.

❒ If you cannot identify the printer you want to configure, check the printer
name against the configuration page printed from the printer. For details
about printing a configuration page, see Printer Reference. 

❒ If no printer names appear in the list, match the frame types of IPX/SPXs
for the computer and printer. Use the [Network] dialog box of Windows to
change the frame type of the computer.

Setting Up as a Print Server (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to connect the machine as a print server using Net-
Ware 4.x, NetWare 5 / 5.1, or NetWare 6 / 6.5.

Important

❒ When using the printer as a print server in NetWare 4.x, NetWare 5 / 5.1, or
NetWare 6 / 6.5, set it to the NDS mode.

❒ When using NetWare 5 / 5.1 or NetWare 6 / 6.5, set the printer as a print server.

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Wizard], and then click [OK].
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D Select the printer you want to configure, and then click [Next].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E Click [Login].

A dialog box for entering the login user name and password appears.

F Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

G Click [Configuration] in the left area, and then click [NetWare].

H Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

I Click [Logout].

Reference

p.19 “Setting Up as a Print Server (NetWare 3.x)”

Using Pure IP in the NetWare 5 / 5.1 or 6 / 6.5 Environment

Follow the procedure below to connect the machine as a print server in a pure IP
environment of NetWare 5 / 5.1 or NetWare 6 / 6.5.

Important

❒ When creating a queued print server in a pure IP environment of NetWare 5 /
5.1 or NetWare 6 / 6.5, create a print queue on the file server using NetWare
Administrator.

❒ This printer is not available as a remote printer for use in a pure IP environ-
ment.

❒ To use the printer in a pure IP environment, set it to IPv4.

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Select the object in which the print queue is located in the directory tree,
and then click [Create] on the [Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.
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E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Select the object in which the printer is located, and then click [Create] on
the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name.

K Select the [Define additional properties] check box, and then click [Create].

L Click [Assignments], and then click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].

P Check the settings, and then click [OK].

Q Select a context specified using NIB Setup Tool, and then click [Create] on
the [Object] menu.

R In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

S In the [Print Server Name] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

T Select the [Define additional properties] check box, and then click [Create].

U Click [Assignments], and then click [Add] in the [Assignments] area.

V In the [Available objects] box, click the queue you created, and then click [OK].

W Check the settings, and then click [OK].
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Setting up using NIB Setup Tool

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select the printer you want to configure, and then click [Next].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E Click [Login].

A dialog box for entering the [Login User Name:] and [Login Password:] appears.

F Enter the user login user name and password, and then click [Login].

For details about the login name and password, consult your network admin-
istrator.

G Click [Configuration] in the left area, and then click [NetWare].

H Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

I Click [Logout].

Reference

p.19 “Setting Up as a Print Server (NetWare 3.x)”

Setting Up as a Remote Printer (NetWare 3.x)

Follow the procedure below to use the machine as a remote printer under Net-
Ware 3.x.

Setting up using PCONSOLE

A Enter “PCONSOLE” from the command prompt.

F:> PCONSOLE

B Create a print queue.

When using the existing print queue, go to the procedure for creating a printer.

C From the [Available Options] menu, select [Print Queue Information], and then
press the {Enter} key.

D Press {Insert} key, and then enter a print queue name.
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E Press {Esc} key to return to the [Available Options] menu.

F Set up the network connection to a printer.

G On the [Available Options] menu, click [Print Server Information], and then press
the {Enter} key.

H To create a new print server, press the {Insert} key, and then enter a print
server name.

For a currently defined print server, select a print server in the [Print Server]
list.

Use the same printer name specified using NIB Setup Tool.

I From the [Print Server Information] menu, select [Print Server Configuration].

J From the [Print Server Configuration] menu, select [Printer Configuration].

K Select the printer indicated as [Not Installed].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

L To change the printer name, enter a new name.

A name “printer x” is assigned to the printer. The “x” stands for the number
of the selected printer.

M As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automatical-
ly configured.

N Press the {Esc} key, and then click [Yes] on the confirmation message.

O Press the {Esc} key to return to [Print Server Configuration Menu].

P Assign print queues to the created printer.

Q From [Print Server Configuration Menu], select [Queues Serviced By Printer].

R Select the printer created.

S Press the {Insert} key to select a queue serviced by the printer. 

You can select several queues.

T Follow the instructions on the screen to make other necessary settings.

Following these steps, check that the queues are assigned.

U Press the {Esc} key until "Exit?" appears, and then select [Yes] to exit
PCONSOLE.
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V Start the print server by entering the following from the console of the Net-
Ware server.

 If the print server is in operation, quit and restart it.

❖ To quit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Note

❒ If the printer works as configured, the message "Waiting for job" appears.

Setting up using NIB Setup Tool

A Log on to the file server as a supervisor or supervisor equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select the printer you want to configure, and then click [Next].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E Click [Login].

A dialog box for entering the [Login User Name:] and [Login Password:] appears.

F Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

G Click [Configuration] in the left area, and then click [NetWare].

H Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

I Click [Logout].

Reference

p.19 “Setting Up as a Print Server (NetWare 3.x)”
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Setting Up as a Remote Printer (NetWare 4.x, 5 / 5.1, 6 / 6.5)

Follow the procedure below to use the printer as a remote printer under Net-
Ware 4.x, 5 / 5.1 and 6 / 6.5.

Important

❒ To use the printer as a remote printer under NetWare 4.x, 5 / 5.1, 6 / 6.5, set
it to NDS mode.

❒ Do not use the printer as a remote printer when Pure IP is used. 

Setting up using NWadmin

A From Windows, start NWadmin.

For details about NWadmin, see the NetWare manuals.

B Set up the network connection to a print queue. Select the object in which
the print queue is located in the directory tree, and then click [Create] on the
[Object] menu.

C In the [Class of new object] box, click [Print Queue], and then click [OK].

D In the [Print Queue Name] box, enter the name of the print queue.

E In the [Print Queue Volume] box, click [Browse].

F In the [Available objects] box, click the volume in which the print queue is
created, and then click [OK].

G Check the settings, and then click [Create].

H Set up the network connection to a printer. Select the object in which the
printer is located, and then click [Create] on the [Object] menu.

I In the [Class of new object] box, click [Printer], and then click [OK]. For Net-
Ware 5, click [Printer (Non NDPS)].

J In the [Printer name] box, enter the printer name

K Select the [Define additional properties] check box, and then click [Create].

L Assign print queues to the created printer. Click [Assignments], and then
click [Add] in the [Assignments] area.

M In the [Available objects] box, click the queue you created, and then click [OK].

N Click [Configuration], click [Parallel] in the [Printer type] list, and then click
[Communication].

O Click [Manual load] in the [Communication type] area, and then click [OK].
Check the settings, and then click [OK].
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P Set up the network connection to a print server. Select a context specified
using NIB Setup Tool, and then click [Create] on the [Object] menu.

Q In the [Class of new object] box, click [Print Server], and then click [OK]. For
NetWare 5, click [Print Sever (Non NDPS)].

R In the [Print Server Name:] box, enter the print server name.

Use the same print server name specified using NIB Setup Tool.

S Select the [Define additional properties] check box, and then click [Create].

T Assign the printer to the created print server. Click [Assignments], and then
click [Add] in the [Assignments] area.

U In the [Available objects] box, click the queue you created, and then click [OK].

V In the [Printers] area, click the printer you assigned, and then click [Printer
Number] 

W Enter the printer number, and then click [OK]. Check the settings, and then
click [OK].

Use the same printer number specified as the remote printer number using
NIB Setup Tool.

X Start the print server by entering the following from the console of the Net-
Ware server.

If the print server is in operation, quit and restart it.

❖ To exit

CAREE: unload pserver

❖ To start

CAREE: load pserver print_server_name

Y Enter the printer server name as the context name, and then press the {Enter}
key.

Z Select the printer name on the context menu, and then press the {Enter} key.
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Setting up using NIB Setup Tool

A Log on to the file server as an administrator or administrator equivalent.

B Start NIB Setup Tool from the [Start] menu.

C Click [Property Sheet], and then click [OK].

D Select the printer you want to configure, and then click [Next].

A dialog box prompting you to perform the remaining configuration tasks in
the Web browser appears. Click [OK], and then wait until Web Image Monitor
starts automatically.

E Click [Login].

A dialog box for entering the [Login User Name:] and [Login Password:] appears.

F Enter the user login name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

G Click [Configuration] in the left area, and then click [NetWare].

H Confirm the settings, and then click [OK].

Configuration is now complete. Wait several minutes before restarting Web
Image Monitor.

I Click [Logout].

Reference

p.19 “Setting Up as a Print Server (NetWare 3.x)”
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2. Monitoring and Configuring
the Printer

Using Web Image Monitor

Using Web Image Monitor, you can check the machine status and change set-
tings.

❖ Available operations
The following operations can be remotely performed using Web Image Mon-
itor from a client computer.

• Displaying machine status or settings

• Checking the print job status or history

• Interrupting currently printing jobs

• Resetting the printer

• Managing the Address Book 

• Making machine settings

• Making network protocol settings

• Making security settings

❖ Configuring the machine
To perform the operations from Web Image Monitor, TCP/IP is required. Af-
ter the machine is configured to use TCP/IP, operations from Web Image
Monitor become available.

❖ Recommended Web browser

• Windows:
Internet Explorer 5.5 SP2 or higher
Firefox 1.0 or higher

• Mac OS:
Safari 1.0, 1.2, 2.0(412.2) or higher
Safari 1.0 or higher
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Note

❒ Safari 2.0(412.2) cannot be used on Mac OS X 10.4.1.

❒ If the previous versions of the Web browser above are used or JavaScript and
cookies are not enabled with the Web browser used, display and operation
problems may occur.

❒ If you are using a proxy server, change the Web browser settings. Contact
your network administrator for information about the settings.

❒ If you are using the Firefox web browser, some elements may not be dis-
played correctly.

❒ The previous page may not appear even after the back button of a Web
browser is clicked. If this happens, click the refresh button of a Web browser.

❒ Updating the machine information is not automatically performed. Click [Re-
fresh] in the display area to update the machine information.

❒ We recommend using Web Image Monitor in the same network. 

❒ You cannot access to the machine from outside the firewall.

❒ When using the machine under DHCP, the IP address may be automatically
changed by the DHCP server settings. Enable DDNS setting on the machine,
and then connect using the machine's host name. Alternatively, set a static IP
address to the DHCP server.

❒ If the HTTP port is disabled, connection to the machine using the machine's
URL cannot be established. SSL setting must be enabled on this machine. For
details, consult your network administrator.

❒ When using the SSL encryption protocol, enter “https://(host name)/”. In-
ternet Explorer must be installed on your computer. Use the most recent
available version. We recommend Internet Explorer 6.0 or later.
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Displaying Top Page

This section explains the Top Page and how to display Web Image Monitor.

A Start your Web browser.

B Enter “http: //(host name)/” in the address bar of a Web browser.

Top Page of Web Image Monitor appears.

If the machine's host name has been registered on the DNS or WINS server,
you can enter it.

When setting SSL, a protocol for encrypted communication, under environment
which server authentication is issued , enter "https://(machine's address)/".

Every Web Image Monitor page is divided into the following areas:

1. Menu area

If you select menu, it's content will be
shown on the work area, or the sub area.

2. Tab area

Details about each menu appears.

3. Header area

The dialog box for switching to the
user mode and administrator mode
appears, and each mode's menu will
be displayed. 

The link to help and dialog box for
keyword search appears.

4. Help

Use Help to view or download Help
file contents.

5. Display area

Displays the contents of the item se-
lected in the menu area.

Machine information in the display
area is not automatically updated.
Click [Refresh] at the upper right in the
display area to update the machine in-
formation. Click the Web browser's
[Refresh] button to refresh the entire
browser screen.

ASC006S
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Note

❒ When using a host name under Windows Server 2003 with IPv6 protocol,
perform host name resolution using an external DNS server. The host file
cannot be used.

When user authentication is set

Login (using Web Image Monitor)

Follow the procedure below to log on when user authentication is set.

A Click [Login].

B Enter a login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Note

❒ For user code authentication, enter a user code in [Login User Name], and
then click [Login].

❒ The procedure may differ depending on the Web browser used.

Log Off (using Web Image Monitor)

Click [Logout] to log off.

Note

❒ When you log on and made the setting, always click [Logout].
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About Menu and Mode

There are two modes available with Web Image Monitor: user mode and admin-
istrator mode.

Displayed Items may differ depending on the machine type.

❖ About User Mode
In the user mode, machine status, settings, and print job status can be viewed,
but the machine settings cannot be changed.

1. Home

The [Status], [Device Info], and [Counter]
tab are displayed. Details of the tab
menu are displayed on the work area.

2. Job

Display all print files.

3. Configuration

Display current machine and network
settings.

ASC007S
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❖ Administrator Mode
In the administrator mode, you can configure various machine settings.

1. Home

The [Status], [Device Info], and [Counter]

tab are displayed. Details of the tab
menu are displayed on the work area.

2. Job 

Display all print files.

3. Address Book 

User information can be registered,
displayed, changed, and deleted.

4. Configuration 

Make system settings for the machine,
interface settings, and security.

5. Reset Device 

Click to reset the printer. If a print job
is being processed, the printer will be
reset after the print job is completed.
This button is located on Top Page.

6. Reset Printer Job 

Click to reset current print jobs and
print jobs in queue. This button is lo-
cated on Top Page.

Access in the Administrator Mode

Follow the procedure below to access Web Image Monitor in the administrator
mode.

A On Top Page, click [Login].

The window for entering the login user name and password appears.

B Enter your login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

ASC008S
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Displaying Web Image Monitor Help

When using Help for the first time, clicking either [Help] in the header area or the
icon marked "?" in the display area makes the following screen appear, in which
you can view Help in two different ways, as shown below:

❖ Viewing Help on our Web site
Downloading Help to your computer

❖ Downloading and Checking Help
You can download Help to your computer. As the Help URL, you can specify
the path to the local file to view the Help without connecting to the Internet.

Note

❒ By clicking [Help] in the header area, the contents of Help appear.

❒ By clicking "?", the Help icon in the display area, Help for the setting items in
the display area appears.

Downloading Help

A In the [OS] list, select the operating system.

B In the [Language] list, select the language.

C Click [Download].

D Download Help by following the instructions on the screen.

E Store the downloaded compressed file in a location, and then decompress
the file.

To view the downloaded Web Image Monitor Help, set the path to the loca-
tion of the decompressed file.

Linking the URL of the Help File to the [Help] Button.

You can link the URL of the help file on a computer or Web server to the [Help] button.

A Log on to Web Image Monitor in the administrator mode.

B In the menu area, click [Configuration].

C Click [Webpage].

D In the [Set Help URL Target] box, enter the URL of the help file.

If you saved the help file to "C:\HELP\EN", enter "file://C:/HELP/". For ex-
ample, if you saved the file to a Web server, and the URL of the index file is
"http:// a.b.c.d/HELP/EN/index.html", enter "http://a.b.c.d/HELP/".

E Click [OK].
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Using SmartDeviceMonitor for Admin

Using SmartDeviceMonitor for Admin, you can monitor the network printers.
Also, you can change the configuration of the network interface board using
TCP/IP or IPX/SPX.

Important

❒ IPv6 cannot be used on this function.

❖ Protocol stack provided with Operating System

• Windows 95/98/Me
TCP/IP
IPX/SPX
NetWare
NetWare Client32 for Windows 95
IntraNetWare Client for Windows 95
Novell Client for Windows 95/98/Me

• Windows 2000
TCP/IP
IPX/SPX
NetWare
Novell Client for Windows NT/2000/XP

• Windows Server 2003
TCP/IP
IPX/SPX

• Windows XP
TCP/IP
IPX/SPX
Novell Client for Windows NT/2000/XP

• Windows NT 4.0
TCP/IP
IPX/SPX
Client Service for NetWare
NetWare Client32 for Windows NT
IntraNetWare Client for Windows NT
Novell Client for Windows NT/2000/XP

❖ Available operations
The following functions are available:

• Limits settings done from the control panel, and disables changes made to
certain items.

• Enables selection of paper type loaded in the machine.

• Switches to, and comes out of Energy Saver mode.

• Checks information about printing, paper quantity, etc.

• Simultaneously monitors multiple printers. When there are many printers,
you can create groups and classify printers to facilitate management.
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• Checks the machine's network settings and detailed device information.

• Enables you to change the machine's network settings.

• You can check details of print jobs sent from a computer.

• Allows you to check job histories of printed, faxed (LAN-Fax), scanned,
and photocopied documents identified by user codes.

• Allows selection of functions such as printing and scanning for each user code.

• Fax numbers and e-mail addresses stored in the machine can be changed
and saved by computer.

• You can check each fax job history entry.

• You can make settings for and display the status changes of group devices.

• Using Address Management Tool, you can manage LAN-Fax numbers,
user names for Scan to Folder, and addresses for sending and receiving In-
ternet faxes.

• The e-mail sender’s name and folder can be protected.

Installing SmartDeviceMonitor for Admin

Follow the procedure below to install SmartDeviceMonitor for Admin

A Quit all applications currently running.

B Insert the CD-ROM into the CD-ROM drive.

The installer starts.

C Select an interface language, and then click [OK].

The default interface language is English.

D Click [SmartDeviceMonitor for Admin].

E Click [Next >].

The software license agreement appears in the [License Agreement] dialog box.

F After reading through its contents, click [Yes].

G Follow the instructions on the screen.

A message appears when the installation is completed.

H Click [OK].

A message about restarting the computer may appear. Restart the computer
to complete installation.

Note

❒ Auto Run may not work under certain operating system settings. In this
case, launch “SETUP.EXE” located on the CD-ROM root directory.

❒ If you are required to restart the computer after installing SmartDevice-
Monitor for Admin, restart the computer and continue the configuration.



Monitoring and Configuring the Printer

38

2

Changing the Network Interface Board Configuration

Follow the procedure below to change the network interface board configura-
tion using SmartDeviceMonitor for Admin.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts when the network interface board is default.

E Click [Web browser], and then click [OK].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears. 

F Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator. 

G Configure settings using Web Image Monitor.

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Reference

p.29 “Using Web Image Monitor”
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Locking the Menus on the Machine's Control Panel

Follow the procedure below to lock the menus on the machine's control panel.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine.

D On the [Tools] menu, point to [Device Settings], and then click [System].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

The [System] page of Web Image Monitor appears. Enter required setting
items.

F Select [Level 1] or [Level 2] on the [Protect Printer Display Panel] in “General Set-
tings”.

G Click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Note

❒ For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.
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Changing the Paper Type

Follow the procedure below to change the paper type.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, point to [Device Settings], and then click [Paper].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

The [Paper] page appears. 

F Select a paper type in the [Paper Type] list for each tray.

Enter required setting items.

G Click [OK].

H Click [Logout].

I Quit Web Image Monitor.

J Quit SmartDeviceMonitor for Admin.

Note

❒ For details about setting items, see Help in the [Device Settings] on [Configu-
ration] page.
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Managing User Information

Follow the procedure below to manage the user's information using SmartDe-
viceMonitor for Admin.

Prints jobs can be managed and functions restricted by user codes.

Starting User Management Tool

Follow the procedure below to start User Management Tool.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine you want to manage.

D On the [Tools] menu, click [User Management Tool].

The dialog box for entering the login user name and password appears.

E Enter the login user name and password, and then click [OK].

For details about the user name and password, consult your network admin-
istrator.

User Management Tool starts.

Note

❒ For details about User Management Tool, see SmartDeviceMonitor for Ad-
min Help.

Displaying the Number of Sheets Printed

Follow the procedure below to display the number of sheets printed under each
user code.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

The number of pages printed under each user code appears.

C Click [Exit] on the [File] menu to quit User Management Tool.
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Exporting the information about the number of pages printed

Follow the procedure below to export the information of the number of pages
printed under each user code as a .csv file.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C On the [File] menu, click [Export User Statistics List].

D Specify the save location and file name, and then click [Save].

E Click [Exit] on the [File] menu to quit User Management Tool.

Resetting the number of pages printed to 0.

Follow the procedure below to reset the number of pages printed under each
user code to 0.

A Start SmartDeviceMonitor for Admin User Information Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C Click the user whose information you want to reset.

D On the [Edit] menu, click [Reset User Counters].

E Select the check box of the items you want to reset, and then click [OK].

A confirmation message appears.

F Click [OK].

The number of pages printed is reset to 0.

G On the [Edit] menu, click [Apply Settings].

Changes are applied to information on the [User Counter Information] tab.

H Click [Exit] on the [File] menu to quit User Management Tool.
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Restricting Functions

Follow the procedure below to restrict use of individual functions.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [User Counter Information] tab of User Management Tool.

C Click the user whose functions you want to restrict.

D On the [Edit] menu of User Management Tool, click [Restrict Access To De-
vice].

E Select the check box of the functions you want to restrict.

F Click [OK].

A confirmation message appears.

G Click [Yes].

The settings are applied.

Setting Applicable Functions to New Users

Follow the procedure below to add new users and set functions applicable to
them.

A Start SmartDeviceMonitor for Admin User Management Tool.

B Click the [Access Control List] tab of User Management Tool.

C On the [Edit] menu, click [Add New User].

D Enter the user code and user name.

E Select the check box of the functions applicable to the new user.

If the check boxes are unavailable, there is no restriction to use that function.

F Click [OK].

The new user is added.

G On the [Edit] menu, click [Apply Settings].

The settings are applied.

H Click [Exit] on the [File] menu to quit User Management Tool.

Note

❒ For details about setting restrictions, see SmartDeviceMonitor for Admin
Help.
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Configuring the Energy Saver Mode

Follow the procedure below to configure Energy Saver mode.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select the machine whose settings you want to make.

To make settings for all machines in the selected group, select no machine.

D On the [Group] menu, point to [Energy Save Mode], point to [Set Individually] to
make the settings for only the selected machine or point to [Set By Group] to
make the settings for all machines in the selected group, and then click [On],
[Off], or [Timer  Settings ...].

E Quit SmartDeviceMonitor for Admin.

Note

❒ For details about the setting for Energy Saver mode, see SmartDeviceMon-
itor for Admin Help.

Setting a Password

Follow the procedure below to set a password.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C In the list, select a machine whose configuration you want to change.

D On the [Tools] menu, click [NIB Setup Tool].

NIB Setup Tool starts when the network interface board is default.

E Click [Web browser], and then click [OK].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.
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F Enter the login user name and password, and then click [Login].

For details about the user name and password, consult your network admin-
istrator.

G Click [Configuration].

H Click [Program/Change Administrator] on the [Device Settings] area, and then
change the settings.

I Click [OK].

J Click [Logout].

K Quit Web Image Monitor.

L Quit SmartDeviceMonitor for Admin.

Checking the Machine Status

Follow the procedure below to check machine status.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C To obtain status details, select the machine in the list, and then click [Open]
on the [Device] menu.

The machine status appears in the dialog box.

D Click [System] or [Printer].

The machine status appears in the dialog box.

E Click [Close].

F Quit SmartDeviceMonitor for Admin.

Note

❒ For details about items in the dialog box, see SmartDeviceMonitor for Ad-
min Help.
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Changing Names and Comments

Follow the procedure below to change the names and comments of the machine.

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C  Select a machine in the list, and then click [NIB Setup Tool] on the [Tools]
menu.

NIB Setup Tool starts when the network interface board is default. 

D Click [Web browser], and then click [OK].

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

E Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

F Click [Configuration].

G Click [System] on the [Device Settings] area, and then change the settings.

H Click [OK].

I Click [Logout].

J Quit Web Image Monitor.

K Quit SmartDeviceMonitor for Admin.

Note

❒ In the [Device name] box, enter a device name on the machine using up to
31 characters.

❒ In the [Comment] box, enter a comment on the machine using up to 31 char-
acters.
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Load Fax Journal

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine in the list, and then click [Load Fax Journal] on the [Tools]
menu.

A Web browser opens and the window for entering the login user name and
password for the Web Image Monitor administrator appears.

D Enter the login user name and password, and then click [Login].

For details about the login user name and password, consult your network
administrator.

Load Fax Journal area appears in the Web Image Monitor.

E Click [Logout].

F Quit Web Image Monitor.

G Quit SmartDeviceMonitor for Admin.

Note

❒ For details, see Help in [Load Fax Journal] area.
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Managing Address Information

A Start SmartDeviceMonitor for Admin.

B On the [Group] menu, point to [Search Device], and then click [IPv4], [IPX/SPX]
or [IPv4 SNMPv3].

A list of machines using the selected protocol appears.

Select the protocol of the machine whose configuration you want to change.

If you are using IPv4 SNMPv3, enter the user authentication.

C Select a machine in the list, and then click [Address Management Tool]on the
[Tools] menu.

The dialog box for entering the login user name and password appears.

D Enter the login user name and password, and then click [OK].

Address Management Tool starts.

 For details about the login user name and password, consult your network
administrator. 

Note

❒ For details, see Address Management Tool Help.
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Using SmartDeviceMonitor for Client

To view the status of machines using SmartDeviceMonitor for Client, configure
SmartDeviceMonitor for Client beforehand.

Monitoring Printers

Follow the procedure below to monitor the machine using SmartDeviceMonitor
for Client.

A Right-click the SmartDeviceMonitor for Client icon, point to [Property], and
then click [Option...].

The [SmartDeviceMonitor for Client - Options] dialog box appears.

B Select the machine you want to monitor, and then select the [To be Monitored]
check box in the Monitoring Information Settings area.

To display the machine status in the task tray using the SmartDeviceMonitor
for Client icon, select the [Displayed on Task Bar] check box.

C Click [OK].

The dialog box closes and the configured machine is monitored.

Note

❒ For details about status icons, see SmartDeviceMonitor for Client Help.

Checking the Machine Status

Follow the procedure below to check machine status using SmartDeviceMonitor
for Client.

A For status details, right-click the SmartDeviceMonitor for Client icon, and
then click the machine.

The machine status appears in the dialog box.

Note

❒ For details about items in the dialog box, see SmartDeviceMonitor for Cli-
ent Help.
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When Using IPP with SmartDeviceMonitor for Client

When using IPP with SmartDeviceMonitor for Client, note the following:

• The network printer can only receive one print job from SmartDeviceMonitor
for Client at a time. While the network printer is printing, another user cannot
access it until the job is finished. In this case, SmartDeviceMonitor for Client
tries to access the network printer until the retry interval expires.

• If SmartDeviceMonitor for Client cannot access the network printer and times
out, it will stop sending the print job. In this case, you should cancel the
paused status from the print queue window. SmartDeviceMonitor for Client
will resume access to the network printer. You can delete the print job from
the print queue window, but canceling a print job printed by the network
printer might cause the next job sent from another user to be incorrectly print-
ed.

• If a print job sent from SmartDeviceMonitor for Client is interrupted and the
network printer cancels the job because something went wrong, send the
print job again.

• Print jobs sent from another computer do not appear in the print queue win-
dow, regardless of protocol.

• If various users send print jobs using SmartDeviceMonitor for Client to net-
work printers, the printing order might not be the same as that in which the
jobs were sent.

• An IP address cannot be used for the IPP port name because the IP address is
used for the SmartDeviceMonitor for Client port name.

• When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued, enter "https://(machine's ad-
dress)/". Internet Explorer must be installed on your computer. Use the
highest version. Internet Explorer 6.0 or higher is recommended.

• If the [Security Alert] dialog box appears when accessing the machine using IPP
to create or configure an IPP port, or when printing, install the certificate. To
select the certificate store location when using Certificate Import Wizard,
click [Place all certificates in the following store], and then click [Local Computer]
under [Trusted Root Certification Authorities].

Note

❒ For details about SSL settings, consult your network administrator.
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Printer Status Notification by E-Mail

Whenever a paper tray becomes empty or paper is jammed, an e-mail alert is is-
sued to the registered addresses to notify the printer status.

For this notification, you can make the e-mail notification settings.

Notification timing and e-mail content can be set.

You can be notified of the following events:

• Service call.

• Toner cartridge is empty.

• Toner cartridge is nearly empty.

• Paper has jammed.

• Open door is detected.

• The paper tray is empty.

• The paper tray is nearly empty.

• A paper tray error occurred.

• Output paper tray is full.

• Stapler has no staples.

• Log Error.

Note

❒ When the service call is set, following call results can be sent.

• Failure automatic call success

• Failure automatic call out of time

• Failure automatic call failure

• Consumable automatic call success

• Remote machine check failure

• Firmware update confirmed

❒ Other call results can be displayed, depending on the machine type.

❒ For details about the service call, contact your service or sales representative.

A Open a Web browser, and then enter “http://(machine's address)/” in the
address bar.

Top Page of Web Image Monitor appears.

When setting SSL, a protocol for encrypted communication, under environ-
ment which server authentication is issued , enter “https://(machine's ad-
dress)/”.

B Click [Login] on Top Page of Web Image Monitor.

The window for entering the login user name and password appears.
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C Enter the login user name and password, and then click Login.

For details about the login user name and password, consult your network
administrator.

D In the menu area, click [Configuration].

E Click [E-mail] on the [Device Settings] area.

FMake the following settings:

• Items in the Reception column: Make the necessary settings for sending
and receiving e-mail. 

• Items in the SMTP column: Configure the SMTP server. Check your mail-
ing environment, and then specify the necessary items. You can also per-
form mail authentication for the SMTP server.

• Items in the POP before SMTP column: Configure the POP server. Check
your mailing environment, and then specify the necessary items. You can
also perform mail authentication for the POP server.

• Items in the POP3/IMAP4 column: Configure the POP3 or IMAP4 server.
Check your mailing environment, and then specify the necessary items.

• Items in the E-mail Communication Port column: Configure the port to be
used for access to the mail server.

• Items in the FAX E-mail Account column: Specify internet fax addresses,
user names, and password settings.

• Items in the E-Mail Notification Account column: Specify these items if
you want to use on-demand e-mail notification.

G Click [OK].
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Auto E-mail Notification

A Click [Configuration] in the menu area, and then click [Auto E-mail Notification]
on the [Device Settings] area.

The dialog box for making notification settings appears.

BMake the following settings:

• Notification Message: You can set this according to your needs, for exam-
ple, the machine's location, service representative contact information.

• Items in the Groups to Notify column: E-mail notification addresses can be
grouped as required.

• Items in the Select Groups/Items to Notify column: Select groups for each
notification type, such as machine status and error.
To make detailed settings for these items, click [Edit] next to [Detailed Set-
tings of Each Item].

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.

On-demand E-mail Notification

A Click [Configuration] in the menu area, and then click [On-demand E-mail Notifi-
cation] on the [Device Settings] area.

The dialog box for making notification settings appears.

BMake the following settings:

• Notification Subject: Enter a text string to be added to the subject line of re-
turn e-mails.

• Items in Notification Message column: You can set this according to your
needs, for example, the machine's location, service representative contact
information.

• Items in the Access Restriction to Information column: Select whether to
restrict accesses based on a specific category of information.

• Items in the Receivable E-mail Address/Domain Name Settings column:
Enter an e-mail address or domain name to use for requesting information
by e-mail and to receive its return e-mail.

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.
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Mail authentication

You can configure mail authentication to prevent illegal use of the mail server.

❖ SMTP Authentication
Specify SMTP authentication.
When mail is sent to the SMTP server, authentication is performed using the
SMTP AUTH protocol by prompting the mail originator to enter the user
name and password. This prevents illegal use of the SMTP server.

A In the menu area, click [E-mail].

B Make the following settings:

• SMTP Authentication: Enable or disable SMTP authentication.

• SMTP Auth. E-mail Address: Enter the e-mail address.

• SMTP Auth. User Name: Enter the SMTP account name.

• SMTP Auth. Password: To set or change the password for SMTP AUTH.

• SMTP Auth. Encryption: Select whether to encrypt the password or not. 
[Encryption]-[Auto Select]: If the authentication method is PLAIN,
LOGIN, CRAM-MD5, or DIGEST-MD5.
[Encryption]-[Active]: If the authentication method is CRAM-MD5 or DI-
GEST-MD5.
[Encryption]-[Inactive]: If the authentication method is PLAIN or LOGIN.

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.

❖ POP before SMTP Authentication
Select whether to log on to the POP3 server before sending e-mail.

A In the menu area, click [E-mail].

B Make the following settings:

• POP before SMTP: Enable or disable POP before SMTP.

• POP E-mail Address: Enter the e-mail address.

• POP User Name: Enter the POP account name.

• POP Password: To set or change the POP password.

• Timeout setting after POP Auth.: Enter the time available before con-
necting to the SMTP server after logging on to the POP server. 

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.
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On-demand E-mail Notification

To use on-demand e-mail notification, perform the following configuration
tasks in Web Image Monitor.

A In the menu area, click [E-mail].

B Make the following settings:

• E-mail Notification E-mail Address: Enter the address using alphanumeric
characters.

• Receive E-mail Notification: Specify whether to use on-demand e-mail no-
tification.

• E-mail Notification User Name: Enter the administrator's user name as the
mail originator name.

• E-mail Notification Password: Enter the password of the mail notification
user.

C Click [OK].

D Click [Logout].

E Quit Web Image Monitor.

❖ Format of on-demand e-mail messages
To use mail notification, you need to send an on-demand e-mail message to
this machine.
Using your mail software, enter the following:

Note

❒ A mail message must be within 1 MB in size.

❒ E-mail may be incomplete if sent immediately after power on.

❖ Subject field
Format: devicestatus?parameter-name=parameter[&=parameter][&=param-
eter]...

Note

❒ The Subject field is case-insensitive.

❒ Parameter names can be written in any order.

Item Description

Subject (Referred to as Subject) Enter a request regarding the device. For de-
tails, see the table below.

From (Referred to as From) Specify a valid mail address. The device in-
formation will be sent to the address speci-
fied here.
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❖ Subject field coding examples

❖ Parameters

❖ Parameters specifying the information to be obtained

❖ Parameters specifying the mail format

Note

❒ HTML and XML can be selected for subject field, but output is text only.

❖ Parameters that specify the language for mail bodies

Coding example Action

devicestatus?request=sysconfig&for-
mat=text&lang=en

The device's system configuration informa-
tion will be sent in an English text format.

devicestatus?request=sysconfig The device's system configuration informa-
tion will be sent in a preset format and lan-
guage.

Parameter Meaning Default

request Information to be obtained Mandatory

format Mail format Mail will be sent in the for-
mat preset for each mail ad-
dress.

lang Language for mail body Mail will be sent in the lan-
guage preset for each mail 
address.

Information to be obtained Parameter

System configuration information sysconfig

Network configuration information netconfig

Printer configuration information prtconfig

Supplies information supply

Device status information status

Mail format Parameter

Text text

HTML html

XML xml

Language Parameter

Japanese ja

English en



Remote Maintenance by telnet

57

2

Remote Maintenance by telnet

Important

❒ Remote Maintenance should be password-protected so that access is allowed
to administrators only. 

❒ The password is the same as the one of Web Image Monitor administrator.
When the password is changed using "mshell", other passwords change also.

❒ Some command cannot be set depending on the model type.

Using telnet

Follow the procedure below to use telnet.

Important

❒ Only one user at a time can log on to perform remote maintenance.

A Use the IP address or the host name of the machine to start telnet.

% telnet host name

B Enter your user name and password.

For details about the user name and password, consult your network admin-
istrator.

For user authentication, enter a login user name and password.

For user code authentication, enter a user code in User Name.

C Enter a command.

D Quit telnet.

msh> logout

The configuration message about saving the changes appears.

E Enter "yes" to save the changes, and then press the {Enter} key.

If you do not want to save the changes, enter "no", and then press the {Enter}
key. To make further changes, enter "return" at the command line, and then
press the {Enter} key.

Note

❒ If the message "Can not write NVRAM information" appears, the changes
are not saved. Repeat the procedure above.

❒ When the changes are saved, the network interface board is reset automat-
ically with that changes.

❒ When the network interface board resets, the print job in print process will
be printed. However, print jobs in queue will be canceled.
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access

Use the “access” command to view and configure access control. You can also
specify two or more access ranges.

❖ View settings

msh> access

❖ IPv4 Configuration

msh> access  range “start-address end-address”

• The star mark represents a target number between 1 and 5. (Up to five ac-
cess ranges can be registered and selected.)

Example: to specify accessible IPv4 addresses between 192.168.0.10 and
192.168.0.20:

msh> access 1 range 192.168.0.10 192.168.0.20

❖ IPv6 Configuration

msh> access  range6 “start-address end-address”

• The star mark represents a target number between 1 and 5. (Up to five ac-
cess ranges can be registered and selected.)

Example: to specify accessible IPv6 addresses between 2001:DB8::100 and
2001:DB8::200.

msh> access 1 range6 2001:DB8::100 2001:DB8::200

❖ IPv6 access mask Configuration

msh> access  mask6 “base-address prefixlen”

• The star mark represents a target number between 1 and 5. (Up to five ac-
cess ranges can be registered and selected.)

Example: to specify accessible IPv6 addresses to 2001:DB8::/32 

msh> access 1 mask6 2001:DB8:: 32

❖ Access control initialization 

msh> access flush

• Use the "flush" command to restore the default settings so that all access
ranges become "0.0.0.0" for IPv4, and "::" for IPv6.

Note

❒ The access range restricts computers from use of the machine by IP address.
If you do not need to restrict printing, make the setting "0.0.0.0" for IPv4, and
"::" for IPv6.

❒ Valid ranges must be from lower (start address) to higher (end address).

❒ If you are running IPv4 or IPv6, up to five access ranges can be registered and
selected.

❒ IPv6 can register and select the range and the mask for each access ranges.
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❒ IPv6 mask ranges between 1 - 128 can be selected.

❒ Up to five access ranges can be specified. The entry is invalid if the target
number is omitted.

❒ You cannot send print jobs, or access Web Image Monitor and diprint from a
restricted IP address.

appletalk

Use the “appletalk” command to view and configure appletalk parameters.

❖ View settings

msh> appletalk

•  [2] means "active" and [0] means "inactive".

• The default is [2].

❖ Changing PAP timeout configuration

msh> appletalk ptimeout value > 0

• Timeout value becomes effective.

msh> appletalk ptimeout value = 0

• Timeout value becomes ineffective.

authfree

Use the “msh> set bonjour” command to display and configure authentication
exclusion control settings.

❖ View Settings

msh> authfree
If print job authentication exclusion is not set, authentication exclusion con-
trol cannot be displayed.

❖ IPv4 address settings

msh> authfree "ID" range_addr1 range_addr2

❖ IPv6 address settings

msh> authfree "ID" range6_addr1 range6_addr2

❖ IPv6 address mask settings

msh> authfree "ID" mask6_addr1 masklen

❖ Parallel/USB settings

msh> authfree [parallel|usb] [on|off]
To enable authfree, set to "on". To disable authfree, set to "off".
Always specify the interface.
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❖ Authentication exclusion control initialization

msh> authfree flush

Note

❒ For IPv4 and IPv6, up to five access ranges can be registered and selected.

autonet

Use the “autonet” command to configure AutoNet parameters.

❖ View settings
The following command displays the current AutoNet settings:

msh> autonet

❖ Configuration
You can configure AutoNet settings.

msh> autonet {on|off}

•  {on} means "active" and {off} means "inactive".

❖ Current interface priority configuration display

msh> autonet priority

❖ Interface priority configuration

msh> autonet priority “interface_name”

• You can give interface's AutoNet parameter priority.

• Priority settings are available when multiple interfaces are installed.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Note

❒ If an interface is not selected, the current interface connection settings remain
in effect.

❒ For details about AutoNet, refer to autonet parameters.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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bonjour(rendezvous)

Use the “bonjour(rendezvous)” command to display bonjour(rendezvous)-re-
lated settings.

❖ View settings
Bonjour settings are displayed.

msh> bonjour

❖ Bonjour service name setting
You can specify the bonjour service name.

msh> bonjour cname “computer name”

• The computer name can be entered using up to 63 alphanumeric charac-
ters.

❖ Bonjour Installation location information setting
You can enter information about the location where the printer is installed.

msh> bonjour location “location”

• Information about location can be entered using up to 32 alphanumeric
characters.

❖ Setting order of priority for each protocol

• diprint

msh> bonjour diprint [0–99]

• lpr

msh> bonjour lpr [0–99]

• ipp

msh> bonjour ipp [0–99]
You can specify the order of priority for “diprint”, “lpr”, and “ipp”. Smaller
numbers indicate higher priority.

❖ IP TTL setting

msh> bonjour ip ttl {1-255}
You can specify the IP TTL (the number of routers a packet can pass through). 

Note

❒ The default is 255.
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❖ Resetting the computer name and location information
You can reset the computer name and location information.

msh> bonjour clear {cname | location}

• cname
Reset the computer name. The default computer name will be displayed
when the computer is restarted.

• location
Reset the location information. The previous location information will be
deleted.

❖ Interface configuration

msh> bonjour linklocal “interface_name”

• If many types of interface are installed, configure the interface that com-
municates with linklocal address.

• If you do not specify an interface, the Ethernet interface is automatically se-
lected.

• wlan can be specified only when the IEEE 802.11b interface is installed.

btconfig

Use the "btconfig" command to make Bluetooth settings.

❖ View settings
Bluetooth settings are displayed.

msh> btconfig

❖ Mode settings
You can set the Bluetooth operation mode to {private} or {public}.

msh> btconfig {private | public}

• The default is {public}.

Interface Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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devicename

Use the "devicename" command to display and change the printer name.

❖ View settings

msh> devicename

❖ Printer name configuration

msh> devicename name “string”

• Enter a printer name using up to 31 alphanumeric characters.

• Set single names for each printer.

❖ Printer name initialization

msh> devicename clear name

• Reset the printer name to its default.

dhcp

Use the "dhcp" command to configure DHCP settings.

❖ View settings
The following command displays the current DHCP settings.

msh> dhcp

❖ Configuration
You can configure DHCP.

msh> dhcp “interface_name” {on|off}

• Click {on} to enable dhcp. Click {off} to disable DHCP.

• If the DNS server address and domain name are obtained from DHCP, be
sure to click {on}.

• wlan can be specified only when the IEEE 802.11 interface is installed.

❖ Current interface priority configuration display

msh> dhcp priority

❖ Interface priority configuration

msh> dhcp priority “interface_name”

• You can select which interface has DHCP parameter priority.

• Priority settings are available when multiple interfaces are installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11 interface
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❖ DNS server address selection

msh> dhcp dnsaddr {dhcp | static}

• Specify whether to obtain the DNS server address from the DHCP server
or use the address set by a user. 

• To obtain the DNS server address from the DHCP server, specify "dhcp".
To use the address set by a user, specify "static". 

❖ Domain name selection

msh> dhcp domainname {dhcp | static}

• Specify whether to obtain the domain name from the DNS server or use the
domain name set by a user.

• To obtain the domain name from the DHCP server, specify "dhcp". To use
the domain name set by a user, specify "static". 

Reference

p.124 “Using DHCP”

p.65 “dns”

p.67 “domainname”

diprint

The direct printing port enables direct printing from a network-connected com-
puter.

Use the “diprint” command to change direct printing port settings.

❖ View settings
The following command displays the current direct printing port settings:

msh> diprint
Example output:

port 9100
timeout=300(sec)
bidirect on
con multi
apl async

• The “port” specifies the port number of the direct printing port.

• The “bidirect” setting indicates whether the direct printing port is bidirec-
tional or not.

❖ Setting timeout

msh> diprint timeout [30~65535]

• You can specify the timeout interval to use when the printer is expecting
data from the network.

• The default is 300 seconds.
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❖ Specifying the number of concurrent connections

msh> diprint con {multi | single}

• The above command specifies the number of concurrent diprint connec-
tions. Specify “multi” for multiple connections or “single” for a single con-
nection.

• The default is “multi”.

dns

Use the “dns” command to configure or display DNS (Domain Name System)
settings.

❖ View settings
The following command displays current DNS settings:

msh> dns

❖ IPv4 DNS server configuration
The following command enables or disables the IPv4 DNS server address:

msh> dns “number” server “server address”
The following command displays a configuration using the IP address
192.168.15.16 on a DNS 1 server:

msh> dns 1 server 192.168.15.16

• You can register IPv4 DNS Server address.

• You can register up to three IPv4 DNS server numbers.

• You cannot use “255.255.255.255” as the DNS server address.

❖ IPv6 DNS server configuration
The following command enables or disables the IPv4 DNS server address:

msh> dns “number” server6 “server address”

• You can register IPv6 DNS Server address.

• You can register up to three IPv6 DNS server numbers.

❖ Dynamic DNS function setting

msh> dns “interface_name” ddns {on|off}

• You can set the dynamic DNS function "active" or "inactive".

•  {on} means "active" and {off} means "inactive".

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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❖ Specifying the record overlap operation

msh> dns overlap {update|add}|msh> dns overlap {update|add}

• You can specify operations performed when records overlap.

• update
To delete old records and register new records.

• add
To add new records and store the old records.

• When CNAME overlaps, it is always changed, irrespective of settings.

❖ CNAME registration

msh> dns cname {on|off}

• You can specify whether to register CNAME.

•  {on} means "active" and {off} means "inactive".

• The CNAME registered is the default name beginning with rnp. CNAME
cannot be changed.

❖ A records registration

msh> dns arecord {dhcp|own}

• {dhcp}
You can specify the method of registering an A record when the dynamic
DNS function is enabled and DHCP is used.

• {own}
To register an A record using the printer as the DNS client.
The DNS server address and the domain name already designated are
used for the registration.

❖ Record updating interval settings

msh> dns interval “time”

• You can specify the interval after which records are updated when using
the dynamic DNS function.

• The updating interval is specified hourly. It can be entered between 1 and
255 hours.

• The default is 24 hours.
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domainname

Use the "domainname" command to display or configure the domain name set-
tings.

You can configure the Ethernet interface or IEEE 802.11b interface.

❖ View settings
The following command displays the current domain name:

msh> domainname

❖ Interface domain configuration

msh> domainname “interface_name”

❖ Setting the Domain Name

msh> domainname “interface_name” name “domain name”

• A domain name can be entered using up to 63 alphanumeric characters.

• The Ethernet interface and IEEE 802.11b interface will have the same do-
main name.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Deleting the Domain Name

msh> domainname “interface_name” clear name

help

Use the "help" command to display the available command list and the proce-
dures for using those commands.

❖ Command list display

msh> help

❖ Display of procedure for using commands

msh> help “command_name”

Interface Interface set

ether Ethernet interface

wlan IEEE 802.11b interface
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hostname

Use the “hostname” command to change the printer name.

❖ View settings

msh> hostname

❖ IPv4 Configuration

msh> hostname “interface_name ” “printer_name”

• Enter the printer name using up to 63 alphanumeric characters.

• You cannot use a printer name beginning “RNP” (in either upper or lower
case).

• The Ethernet interface and IEEE 802.11b interface will have the same print-
er name.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Initializing the printer name for each interface

msh>hostname “interface_name” clear name

ifconfig

Use the "ifconfig" command to view and configure TCP/IP (IP address, subnet
mask, broadcast address, default gateway address) for the printer.

❖ View settings

msh> ifconfig

❖ IPv4 Configuration

msh> ifconfig “interface_name” “parameter” “address”

• If you did not enter an interface name, it is automatically set to the Ethernet
interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

The following explains how to configure an IPv4 address 192.168.15.16 on
Ethernet interface.

msh> ifconfig ether 192.168.15.16

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet Interface

wlan IEEE 802.11b Interface
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❖ IPv6 Configuration

msh> ifconfig ether inet6 interface_name ” “printer_name”
The following explains how to configure a IPv6 address to 2001:DB8::100 with
prefix length 64 on the Ethernet interface.

msh> ifconfig ether inet6 2001:DB8::100 64

❖ Netmask configuration

msh> ifconfig “interface_name” netmask “address”
The following explains how to configure a subnet mask 255.255.255.0 on Eth-
ernet interface.

msh> ifconfig ether netmask 255.255.255.0

❖ Broadcast address configuration

msh> ifconfig “interface_name” broadcast “address”

❖ Changing the Interface

msh> ifconfig “interface” up

• You can specify either the Ethernet interface or IEEE 802.11b interface
when using the optional IEEE 802.11b interface unit.

Note

❒ To get the above addresses, contact your network administrator.

❒ Use the default configuration if you cannot obtain setting addresses.

❒ The IP address, subnet mask and broadcast address are the same as that for
the Ethernet interface and IEEE 802.11b interface.

❒ TCP/IP configuration is the same for both Ethernet and IEEE 802.11 interface.
If interfaces are changed, the new interface inherits the configuration.

❒ Use "0x" as the initial two letters of a hexadecimal address.

info

Use the "info" command to display printer information such as paper tray, out-
put tray, and printer language.

❖ Printer information display

msh> info

Reference

p.92 “Getting Printer Information over the Network”
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ipp

Use the “ipp” command to view and configure IPP settings.

❖ Viewing settings
The following command displays the current IPP settings:

msh> ipp

❖ IPP timeout configuration 
Specify how many seconds the computer waits before canceling an interrupt-
ed print job. The time can be entered between 30 to 65535 seconds.

msh> ipp timeout [30 - 65535]

❖ IPP user authorization configuration
Use IPP user authorization to restrict users to print with IPP. The default is
“off”.

msh> ipp auth {basic|digest|off}

• User authorization settings are “basic” and “digest”.

• If user authorization is specified, register a user name. You can register up
to 10 users.

❖ IPP user configuration
Configure IPP users according to the following messages:

msh> ipp user
The following message appears:

msh> Input user number (1 to 10):
Enter the number, user name, and password.

msh> IPP user name:user1
msh> IPP password:*******
After configuring the settings, the following message appears:

User configuration changed.

ipv6

Use the “ipv6” command to display and configure IPv6 settings.

❖ View Setting

msh> ipv6

❖ IPv6 stateless address

msh> ipv6 stateless {on|off}
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lpr

Use the “lpr” command to view and configure LPR settings.

❖ View Setting

msh> lpr

❖ Checking host name when deleting the job

msh> lpr chkhost {on|off}

netware

Use the “netware” command to view and configure the NetWare settings such
as the print server name or file server name.

❖ Netware Printer Server Names

msh> netware pname character string

• Enter the NetWare print server name using up to 47 characters.

❖ Netware File Server Names

msh> netware fname character string

• Enter the NetWare file server name using up to 47 characters.

❖ Encap type

msh> netware encap {802.3|802.2|snap|ethernet2|auto}

❖ Remote Printer Number

msh> netware rnum {0–254}

❖ Timeout

msh> netware timeout {3–255}

❖ Printer server mode

msh> netware mode pserver
msh> netware mode ps

❖ Remote printer mode

msh> netware mode rprinter
msh> netware mode rp

❖ NDS context name

msh> netware context character string

❖ SAP interval

msh> netware “sap_interval”
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❖ Setting login mode for file server

msh> netware login server

❖ Setting login mode for NDS tree

msh> netware login tree

❖ Setting login mode for NDS tree name

msh> netware tree “NDS name”

❖ File transfer protocol

msh> netware trans {ipv4pri|ipxpri|ipv4|ipx}

• If you do not specify the protocol, the current setting is displayed. 

passwd

Use the “passwd” command to change the remote maintenance password.

❖ Changing the Password

msh> passwd

• Enter the current password.

• Enter the new password.

• Renter the new password to confirm it.

❖ Changing the Password of the administrators using the Supervisor

msh> passwd {Administrator ID}

• Enter the new password.

• Renter the new password to confirm it.

Note

❒ Be sure not to forget or lose the password.

❒ The password can be entered using up to 32 alphanumeric characters. Pass-
words are case-sensitive. For example, "R" is not the same as "r".

Protocol Set Protocol

ipv4pri IPv4+IPX(IPv4)

ipxpri IPv4+IPX(IPX)

ipv4 IPv4

ipx IPX
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pathmtu

Use the “pathmtu” command to display and configure the PathMTU Discovery
service function.

❖ View settings

msh> pathmtu

❖ Configuration

msh> pathmtu {on|off}

• The default is “on”.

• If the MTU size of the sent data is larger than the router's MTU, the router
will declare it impassable, and communication will fail. If this happens, se-
lecting the “pathmtu” to “off” optimizes the MTU size and prevents data
output failure.

• Depending on the environment, information might not be obtained from
the router, and communication will fail. If this happens, select the “pathm-
tu” to “off”.

prnlog

Use the “prnlog” command to obtain printer log information.

❖ Print logs display

msh> prnlog

• Display previous print jobs.

msh> prnlog “ID Number”

• Specify the ID number of the displayed print log information to display ad-
ditional details about a print job.

Reference

p.92 “Getting Printer Information over the Network”.
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route

Use the “route” command to view and control the routing table.

❖ Specified route information display

msh> route get “destination”

• Specify the IPv4 address to destination.
“0.0.0.0” cannot be specified as destination address.

❖ Enabling/disabling specified IPv4 destination

msh> route active {host|net} “destination” {on | off}

• You can turn the specified destination on or off. Host becomes the default
setting.

❖ Adding IPv4 Routing Table

msh> route add {host|net} “destination” “gateway”

• Adds a host or network route to “destination”, and a gateway address to
“gateway” in the table. 

• Specify the IPv4 address to destination and gateway.

• Host becomes the default setting.

❖ Setting the Default IPv4 Gateway

msh> route add default “gateway”

❖ Deleting specified IPv4 destination from Routing Table

msh> route delete {host|net} “destination”

• Host becomes the default setting.

• IPv4 address of destination can be specified.

❖ Setting IPv6 Default Gateway

msh> route add6 default gateway

❖ Adding a specified IPv6 destination to Routing Table

msh> route add6 {destination} prefixlen gateway

• Specify the IPv6 address to destination and gateway.

❖ Deleting a specified IPv6 destination from Routing Table

msh> route delete6 {destination} prefixlen

• Specify the IPv6 address to destination and gateway.

❖ Display information about a specified IPv6 route information

msh> route get6 {destination}

• Specify the IPv6 address to destination and gateway.
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❖ Enabling/disabling a specified IPv6 destination

msh> route active6 {destination} prefixlen {on | off}

❖ Route initialization

msh> route flush

Note

❒ The maximum number of IPv4 routing tables is 16.

❒ The maximum number of IPv6 routing tables is 2.

❒ Set a gateway address when communicating with devices on an external net-
work.

❒ The same gateway address is shared by all interfaces.

❒ “Prefixlen” is a number between 1 and 128.

set

Use the "set" command to set the protocol information display "active" or "inactive".

❖ View settings
The following command displays protocol information (active/inactive).

msh> set ipv4

msh> set ipv6

msh> set appletalk

msh> set netware

msh> set smb

msh> set protocol

• When protocol is specified, information about TCP/IP, AppleTalk, Net-
ware, and SMB appears.

msh> set lpr

msh> set lpr6

msh> set ftp

msh> set ftp6

msh> set rsh

msh> set rsh6

msh> set diprint

msh> set diprint6

msh> set web

msh> set snmp

msh> set ssl

msh> set ssl6

msh> set nrs
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msh> set rfu

msh> set rfu6

msh> set ipp

msh> set ipp6

msh> set http

msh> set http6

msh> set bonjour

msh> set nbt

msh> set ssdp

msh> set ssh

msh> set sftp

msh> set sftp6

❖ Configuration

• Enter “up”to enable protocol, and enter “down” to disable protocol.
You can set the protocol to "active" or "inactive".

msh> set ipv4 {up | down}

• If you disable IPv4, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv4.

• Disabling IPv4 also disables lpr, ftp, rsh, diprint, web, snmp, ssl, ipp, http,
bonjour, and sftp.

msh> set ipv6 {up | down}

• If you disable IPv6, you cannot use remote access after logging off. If you
did this by mistake, you can use the control panel to enable remote access
via IPv6.

• Disabling IPv6 also disables lpr6, ftp6, rsh6, diprint6, ssl6, ipp6, http6, and
sftp6.

msh> set appletalk {up | down}

msh> set netware {up | down}

msh> set smb {up | down}

msh> set lpr {up | down}

msh> set lpr6 {up | down}

msh> set ftp {up | down}

msh> set ftp6 {up | down}

msh> set rsh {up | down}

msh> set rsh6 {up | down}

msh> set diprint {up | down}

msh> set diprint6 {up | down}

msh> set web {up | down}
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msh> set snmp {up | down}

msh> set ssl {up | down}

msh> set ssl6 {up | down}

• If Secured Sockets Layer (SSL, an encryption protocol) function is not
available for the printer, you cannot use the function by enabling it.

msh> set nrs {up | down}

msh> set rfu {up | down}

msh> set rfu6 {up | down}

msh> set ipp {up | down}

msh> set ipp6 {up | down}

msh> set http {up | down}

msh> set http6 {up | down}

msh> set bonjour {up | down}

msh> set ssh {up | down}

msh> set ssdp {up | down}

msh> set nbt {up | down}

msh> set sftp {up | down}

msh> set sftp6 {up | down}

show

Use the "show" command to display network interface board configuration settings.

❖ View settings

msh> show

• If "-p" is added, you can view settings one by one.

Reference

p.100 “Configuring the Network Interface Board”

slp

Use “slp” command to view and configure SLP settings.

msh> slp ttl “ttl_val”

• You can search the NetWare server using SLP in the PureIP environment of
NetWare 5/5.1. Using the "slp" command, you can configure the value of TTL
which can be used by SLP multicast packet.

• The default value of TTL is 1. A search is executed only within a local seg-
ment. If the router does not support multicast, the settings are not available
even if the TTL value is increased.

• The acceptable TTL value is between 1 and 255.
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smb

Use the “smb” command to configure or delete the computer or workgroup
name for SMB.

❖ Computer Name settings 

msh> smb comp “computer name”

• Set computer name using up to 15 characters. Names beginning with
"RNP" or "rnp" cannot be entered.

❖ Working Group Name settings

msh> smb group “work group name”

• Set workgroup name using up to 15 characters

❖ Comment settings

msh> smb comment “comment”

• Set comment using up to 31 characters.

❖ Notify print job completion

msh> smb notif {on | off}

• To notify print job completion, specify “on”. Otherwise, specify “off”

❖ Deleting Computer Name

msh> smb clear comp

❖ Deleting Group Name

msh> smb clear group

❖ Deleting Comment

msh> smb clear comment

❖ View Protocol

msh> smb protocol 
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snmp

Use the “snmp” command to display and edit SNMP configuration settings such
as the community name.

❖ View settings

msh> snmp

• Default access settings 1 is as follows:
Community name: public
IPv4 address: 0.0.0.0
IPv6 address:::
IPX address: 00000000:000000000000
Access type: read-only
Effective Protocol: IPv4/IPv6/IPX

• Default access settings 2 is as follows:
Community name:admin
IPv4 address: 0.0.0.0
IPv6 address:::
IPX address: 00000000:000000000000
Access type: read-write
Effective Protocol: Pv4/IPv6/IPX

• If "-p" is added, you can view settings one by one.

• To display the current community, specify its registration number.

❖ Display

msh> snmp ?

❖ Community name configuration

msh> snmp “number” name “community_name”

• You can configure ten SNMP access settings numbered 1-10.

• The printer cannot be accessed from SmartDeviceMonitor for Admin or
SmartDeviceMonitor for Client if “public” is not registered in numbers 1-
10. When changing the community name, use SmartDeviceMonitor for
Admin and SNMP Setup Tool to correspond with printer settings.

• The community name can be entered using up to 15 characters.

❖ Deleting community name

msh> snmp “number” clear name
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❖ Access type configuration

msh> snmp “number” type “access_type”

❖ Protocol configuration

msh> snmp {ipv4|ipv6|ipx} {on|off}

• Use the following command to set protocols "active" or "inactive": If you
set a protocol "inactive", all access settings for that protocol are disabled.

• Specify "ipv4" for IPv4, "ipv6" for IPv6, or "ipx" for IPX/SPX.

•  {on} means "active" and {off} means "inactive".

• All protocols cannot be turned off concurrently.

❖ Configuration of protocol for each registration number

msh> snmp “number” active {ipv4|ipv6|ipx} {on|off}

• To change the protocol of access settings, use the following command.
However, if you have disabled a protocol with the above command, acti-
vating it here has no effect.

❖ Access configuration

msh> snmp “number” {ipv4|ipv6|ipx} “address”

• You can configure a host address according to the protocol used.

• The network interface board accepts requests only from hosts that have
IPv4, IPv6, and IPX addresses with access types of "read-only" or "read-
write". Enter “0” to have network interface board accept requests from any
host without requiring a specific type of access.

• Enter a host address to deliver "trap" access type information to.

• To specify IPv4 or IPv6, enter "ipv4" or "ipv6" followed by a space, and
then the IPv4 or IPv6 address.

• To specify IPX/SPX, enter "ipx" followed by a space, the IPX address fol-
lowed by a decimal, and then the MAC address of the network interface
board.

❖ sysLocation configuration

msh> snmp location

❖ Deleting sysLocation

msh> snmp clear location

Access type Type of access permission

no not accessible

read read only

write read and write

trap user is notified of trap messages
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❖ sysContact setting

msh> snmp contact

❖ Deleting sysContact

msh> snmp clear contact

❖ SNMP v1v2 function configuration

msh> snmp v1v2 {on|off}

• Specify "on" to enable, and "off" to disable.

❖ SNMP v3 function configuration

msh> snmp v3 {on|off}

• Specify "on" to enable, and "off" to disable.

❖ SNMP TRAP configuration

msh> snmp trap {v1|v2|v3} {on|off}

• Specify "on" to enable, and "off" to disable.

❖ Remote Configuration Authorization configuration

msh> snmp remote {on|off}

• Specify "on" to enable, and "off" to disable the SNMP v1v2 setting.

❖ SNMP v3 TRAP configuration display

msh> snmp v3trap

msh> snmp v3trap {1-5}

• If a number from 1-5 is entered, settings are displayed for that number on-
ly.

❖ Configuring a sending address for SNMP v3 TRAP

msh> snmp v3trap {1-5} {ipv4|ipv6|ipx} “address”

❖ Configuring a sending protocol for SNMP v3 TRAP

msh> snmp v3trap {1-5} active {ipv4|ipv6|ipx} {on|off}

❖ Configuring a user account for SNMP v3 TRAP

msh> snmp v3trap {1-5} account “account_name”

• Enter an account name using up to 32 alphanumeric characters.

❖ Deleting an SNMP v3 TRAP user account

msh> snmp v3trap {1-5} clear account

❖ Configuring an SNMP v3 encryption algorithm

msh> snmp v3auth {md5|sha1}
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❖ Configuring SNMP v3 encryption

msh> snmp v3priv {auto|on}

• Set "auto" for automatic encryption configuration

• Set "on" for mandatory encryption configuration.

sntp

The printer clock can be synchronized with a NTP server clock using Simple
Network Time Protocol (SNTP). Use the "sntp" command to change SNTP set-
tings.

❖ View settings

msh> sntp

❖ NTP server address configuration
You can specify the IP address of the NTP server.

msh> sntp server “IP_address”

❖ Interval configuration

msh> sntp interval “polling_time”

• You can specify the interval at which the printer synchronizes with the op-
erator-specified NTP server. The default is 60 minutes.

• The interval can be entered from 0, or between 16 and 10,080 minutes.

• If you set 0, the printer synchronizes with the NTP server only when you
turn the printer on. After that, the printer does not synchronize with the
NTP server.

❖ Time-zone configuration

msh> sntp timezone “+/-hour_time”

• You can specify the time difference between the printer clock and NTP
server clock. The values are between –12:00 and +13:00.
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spoolsw

Use the “spoolsw” command to view and configure Job Spool settings.

You can only specify diprint, trap, lpr, ipp, ftp, sftp, and smb(TCP/IP) protocol.

• The “spoolsw” command for configuring Job Spool settings is available only
when the optional hard disk is installed.

❖ View settings
The Job Spool setting appears.

msh> spoolsw

❖ Job Spool setting

msh> spoolsw spool {on|off}
Specify “on” to enable Job Spool, or “off” to disable it.

❖ Resetting Job spool setting

msh> spoolsw clear job {on|off}

• When the printer power is cut during job spooling, this determines wheth-
er to reprint the spooled job.

❖ Protocol configuration

msh> spoolsw diprint {on|off}

msh> spoolsw lpr {on|off}

msh> spoolsw ipp {on|off}

msh> spoolsw smb {on|off}

msh> spoolsw ftp {on|off}

msh> spoolsw sftp {on|off}

• You can specify the settings for diprint, lpr, ipp, ftp, sftp, and smb.

ssdp

Use the “ssdp” command to view and configure SSDP settings.

❖ View settings

msh> ssdp

❖ Setting effective time

msh> ssdp profile {1801–86400}
The default is 10800 seconds.

❖ Advertise packet TTL settings

msh> ssdp ttl {1–255}
The default is 4.
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ssh

Use the “ssh” command to view and configure SSH settings.

❖ View settings

msh> ssh

❖ Data compression communication settings

msh> ssh compression {on|off}
The default is "on".

❖ SSH/SFTP communication port setting

msh> ssh port {22, 1024–65535}
The default is 22.

❖ SSH/SFTP communication timeout setting

msh> ssh timeout {0–65535}
The default is 300.

❖ SSH/SFTP communication login timeout setting

msh> ssh logintimeout {0–65535}
The default is 300.

❖ Setting an open key for SSH/SFTP

msh> ssh genkey {512|768|1024} "character string"
Create an open key for SSH/SFTP communication.
Usable characters are ASCII 0x20-0x7e (32 bytes) other than "0".
The default key length is 1024, and the character string is blank.

❖ Deleting open key for ssh/sftp communication

msh> ssh delkey 

Note

❒ If you do not specify a character string, current setting is displayed.
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status

Use the “status” command to display the printer status.

❖ view messages

msh> status

Reference

p.92 “Current Printer Status” 

syslog

Use the “syslog” command to display the information stored in the printer's sys-
tem log.

❖ View message

msh> syslog

Reference

p.107 “System Log Information”

upnp

Use the "upnp" command to display and configure the universal plug and play.

❖ Public URL display

msh> upnp url

❖ Public URL configuration

msh> upnp url "string"

• Enter the URL string in the character string.

❖ Deleting Public URL

msh> upnp clear url
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web

Use the “web” command to display and configure parameters on Web Image
Monitor.

❖ View Settings

msh> web

❖ URL Configuration
You can set URLs linked by clicking [URL] on Web Image Monitor.
Specify "1" or "2" for x as the number corresponding to the URL. Up to two
URLs can be registered and specified.

msh> web url http://”The URL or IP address you want to register”/

❖ Resetting URLs registered as link destinations

msh> web x clear url
Specify "1" or "2" for x as the corresponding number to the URL.

❖ Link name configuration
You can enter the name for URL that appears on Web Image Monitor.
Specify "1" or "2" for x as the corresponding number to the link name.

msh> web name “Name you want to display”

❖ Resetting URL names registered as link destinations

msh> web x clear name
Specify "1" or "2" for x as the number corresponding to the link name.

❖ Help URL Configuration
You can set URLs linked by clicking [Help] or [?] on Web Image Monitor.

msh> web help http://”Help URL or IP address”/help/

❖ Resetting Help URL

msh> web clear help

wiconfig

Use the "wiconfig" command to make settings for IEEE 802.11b.

❖ View settings

msh> wiconfig

❖ View IEEE 802.11b settings

msh> wiconfig cardinfo

• If IEEE 802.11b is not working correctly, its information is not displayed.
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❖ Configuration

msh> wiconfig “parameter”

Parameter Value configured

mode [ap|adhoc|802.11adhoc] You can set the infrastructure mode(ap) , the 
802.11 Ad hoc mode (802.11adhoc), or the ad 
hoc mode (adhoc).

The default is ad hoc mode.

ssid “ID value” You can make settings for the SSID in the in-
frastructure mode.

Usable characters are ASCII 0x20-0x7e (32 bytes).

An SSID value is set automatically to the 
nearest access point if no setting is made.

If no setting is made for the 802.11 ad hoc 
mode, the same values for the infrastructure 
mode or an ASSID value is automatically set. 
The default is blank.

channel frequency “channel no.” You can enable or disable the WEP function. 
To enable the WEP function, specify [on]; to 
disable it, specify [off].

To start the WEP function, enter the correct 
WEP key. The default is “11”.

key [ “key value” ] val [1|2|3|4] You can specify the WEP key when entering 
in hexadecimal.

With a 64-bit WEP, you can use 10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimal.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key, the WEP 
specified by key phrase is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other. Put “0x”on the front 
of WEP key.

You can omit the numbers with “val”. The 
key number is set to 1 when making these 
omissions. The default is blank.
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keyphrase [ “phrase” ] val [1|2|3|4] You can specify the WEP key when entering 
in ASCII.

With a 64-bit WEP, you can use10 digit hex-
adecimals. With a 128-bit WEP, you can use 
26 digit hexadecimals.

Up to four WEP keys can be registered. Spec-
ify the number to be registered with “val”.

When a WEP is specified by key phrase, the 
WEP specified by key is overwritten.

To use this function, set the same key 
number and WEP key for all ports that trans-
mit data to each other.

You can omit the numbers with “val”. The 
key number is set to 1 when making these 
omissions. The default is blank.

encval [1|2|3|4] You can specify which of the four WEP keys 
is used for packet encoding. “1” is set if a 
number is not specified.

wepauth [open|shared] You can set an authorization mode when us-
ing WEP. The specified value and authorized 
mode are as follows:

open: open system authorized (default)

shared: shared key authorized rate

rate [auto|11m|5.5m|2m|1m] You can set the IEEE 802.11b transmitting 
speed.

The speed you specify here is the speed at 
which data is sent. You can receive data at 
any speed.

auto: automatically set (default)

11m: 11 Mbps fixed

5.5m: 5.5 Mbps fixed

2m:2 Mbps fixed

1m: 1 Mbps fixed

security {none|wep|wpa} You can specify the security mode.

none: No encryption(default)S

wep: WEP encryption

wpa: WPA encryption

wpaenc {tkip|ccmp} You can specify WPA encryption key when 
using WPA encryption.

tkip: TKIP (default)

ccmp: CCMP (AES)

wpaauth {wpapsk|wpa} You can specify the WPA authentication 
mode when using WPA encryption.

wpapsk: WPA-PSK authentication(default)

wpa: WPA(802.1X) authentication

Parameter Value configured
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psk "character string" You can specify the Pre-Shared key.

Usable characters: ASCII 0x20-0x7e (8 to 63 
bytes).

The default is blank.

eap {tls|ttls|leap|peap} {chap|msc-
hap|mschapv2|pap|md5|tls}

You can specify the EAP authentication type.

tls: EAP-TLS (default)

ttls: EAP-TTLS

leap: LEAP

peap: PEAP

chap, mschap, mschapv2, pap, md5, or tls 
are settings for the phase 2 method, and 
must be set when using EAP-TTLS orPEAP.

Do not make these settings when using other 
EAP authentication types. 

If you select EAP-TTLS, you can select chap, 
mschap, mschapv2, pap, or md5.

If you select PEAP, you can select mschapv2 
or tls.

username "character string" You can specify the login user name for the 
Radius server.

Usable characters: ASCII 0x20-0x7e(31 bytes) 
other than "@". The default is blank.

username2 "character string" You can specify the phase 2 username for 
EAP-TTLS/PEAP phase 2 authentication.

Usable characters: ASCII 0x20-0x7e (31 
bytes) other than "@". The default is blank.

domain "character string" You can specify the login domain name for 
the Radius server.

Usable characters: ASCII0x20-0x7e (31 bytes) 
other than "@". The default is blank.

password "character string" You can specify the login password for the 
Radius server.

Usable characters: ASCII 0x20-0x7e(128 
bytes). The default is blank.

srvcert {on|off} You can set the server certificate.The default 
is "off".

imca {on|off} You can enable or disable the certificate 
when the intermediate certificate authority is 
present. The default is "off".

srvid "character string" You can set the server ID and subdomain of 
the certificate server.

Parameter Value configured
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wins

Use the "wins" command to configure WINS server settings.

❖ Viewing settings

msh> wins

• If the IPv4 address obtained from DHCP differs from the WINS IPv4 ad-
dress, the DHCP address is the valid address.

❖ Configuration

msh> wins “interface_name” {on | off}

• {on} means "active" and {off} means "inactive".

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

❖ Address configuration
Use the following command to configure a WINS server IP address:

msh> wins “interface_name” {primary|secondary} “IP address”

• Use the “primary” command to configure a primary WINS server IP ad-
dress.

• Use the "secondary" command to configure a secondary WINS server IP
address.

• Do not use “255.255.255.255” as the IP address.

❖ NBT (NetBIOS over TCP/IP) Scope ID Selection
You can specify the NBT scope ID.

msh> wins “interface_name” scope “scope ID”

• The scope ID can be entered using up to 31 alphanumeric characters.

• Be sure to specify the interface.

• wlan can be specified only when the IEEE 802.11b interface is installed.

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface

Interface name Interface configured

ether Ethernet interface

wlan IEEE 802.11b interface
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SNMP

The SNMP agent operating on UDP and IPX is incorporated into the built-in Eth-
ernet board and optional IEEE 802.11b interface unit of this printer.

Using the SNMP manager, you can get information about the printer.

Important

❒ If you changed the machine's community name, change the configuration of
the connected computer accordingly, using SNMP Setup Tool. For details, see
SNMP Setup Tool Help.

The default community names are [public] and [admin]. You can get MIB infor-
mation using these community names.

❖ Start SNMP Setup Tool

• Windows 95/98/Me, Windows 2000, Windows NT 4.0:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [Programs] menu.
Click [SNMP Setup Tool].

• Windows XP:
Click the [Start] button.
Point to [SmartDeviceMonitor for Admin] on the [All Programs] menu.
Click [SNMP Setup Tool].

❖ Supported MIBs(SNMPv1/v2)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

❖ Supported MIBs(SNMPv3)

• MIB-II

• PrinterMIB

• HostResourceMIB

• RicohPrivateMIB

• SNMP-FRAMEWORK-MIB

• SNMP-TARGET-MIB

• SNMP-NOTIFICATION-MIB

• SNMP-USER-BASED-SM-MIB

• SNMP-VIEW-BASED-ACM-MIB
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Getting Printer Information over the 
Network

This section explains details of each item displayed in the printer status and in-
formation.

This manual covers all models, and therefore contains functions and settings
that may not be available for your model.

Current Printer Status

The printer status can be checked using the following commands:

• UNIX: Use the "lpq" command and "rsh", "rcp", “ftp”, and "sftp" parameters. 

• mshell: Use the "status" command. 

Messages Description

Access Restricted The job was canceled because user have no authority. 

Adjusting... The machine is initializing or calibrating. 

Alert at Printer: Yellow LED An error has occurred.

Call Service Center There is a malfunction in the machine.

Canceled The job is reset. 

Canceling Job... The job is being reset. 

Configuring... Setting is being changed. 

Cooling Down Fusing Unit... The fusing unit is cooling down.

Cover Open: ADF The document feeder is open. 

Cover Open: Duplex Unit The cover of the duplex unit is open. 

Cover Open: Finisher Front The front cover of Finisher is open.

Cover Open:Finisher Upper Cover The upper cover of Finisher is open.

Cover Open: Front Cover The front cover is open. 

Cover Open: Lower Right Cover The lower right cover is open. 

Cover Open: Right Cover The right cover is open. 

Cover Open: Upper Exit Cover The upper exit cover is open. 

Data Size Error The data size error occurred. 

Empty: Black Toner The black toner cartridge is almost empty. 

Energy Saver Mode The machine is in Energy Saver Mode.

Envelope Setting Error: None  Printing paper type other than envelope is instructed 
when B2 lever is down.

Envelope Setting Error: Others Printing envelope is instructed when B2 lever is down. 

Error An error has occurred. 
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Error at Printer: Red LED An error has occurred.

Error in Printer An error has occurred.

Error: Address Book An error has occurred in the data of the address book. 

Error: Command Transmission An error has occurred in the machine. 

Error: DIMM Value A memory error occurred. 

Error: Ethernet Board An Ethernet board error has occurred.

Error: Memory Switch A memory switch error has occurred. 

Error: Optional Font An error has occurred in the font file of the machine. 

Error: Optional RAM An error has occurred in the optional memory unit.

Error: Parallel I/F Board An error has occurred in the parallel interface.

Error: PDL An error has occurred in the page description language. 

Error: Rem. Certificate Renewal An error has occurred in the remote sever renewal. 

Error: USB Board An error has occurred in theUSB interface board. 

Error: USB Interface An error has occurred in the USB interface. 

Error: Wireless Card Wireless card is not inserted during start up, or the 
IEEE 802.11b interface unit or the wireless card is tak-
en out after start up .

Error: Wireless Board An error has occurred in the IEEE802.11b interface unit.

Full: Finisher Shift Tray Shift tray of Finisher is full.

Full: Internal Tray 1 Internal tray 1 is full. 

Full: Waste Toner Waste toner is full.

Hex Dump Mode It is a hex dump mode. 

Immed. Trans. not connected It did not connect directly with the other party of the 
transmission. 

Immediate Transmission Failed An error has occurred while transmitting directly. 

In Use: Copier The copier is being used. 

In Use: Fax The fax is being used. 

In Use: Finisher Other functions is using Finisher.

In Use: Input Tray Other functions is using the input tray. 

Independent-supplier Toner Toner that is not recommended is set. 

Key Card not inserted The machine is waiting for key card to be inserted.

Key Card/Counter not inserted The machine is waiting for key card or key counter to 
be inserted.

Key Counter not inserted The machine is waiting for key counter to be left in it.

Loading Toner... Toner is being supplied.

Low: Black Toner The black toner cartridge is not set correctly, or toner 
is almost running out.

Messages Description



Monitoring and Configuring the Printer

94

2

Low: Toner The toner cartridge is not set correctly, or toner is al-
most running out.

Malfunction: Duplex Unit There is a problem with the duplex unit. 

Malfunction: Finisher There is a problem with the finisher.

Malfunction: Ext. Charge Unit There is a problem with the external charge unit.

Malfunction: Tray 1 There is a problem with tray 1. 

Malfunction: Tray 2 There is a problem with tray 2. 

Malfunction: Tray 3 There is a problem with tray 3. 

Malfunction: Tray 4 There is a problem with tray 4. 

Memory Low: Copy Memory shortage has occurred while the copy was 
operating. 

Memory Low: Data Storage Memory shortage has occurred while the document 
was being accumulated. 

Memory Low: Fax Scanning Memory shortage has occurred while transmitting the 
fax. 

Memory Low: Scanning Memory shortage has occurred while the scanner was 
working. 

Miscellaneous Error Other error has occurred. 

Mismatch: Paper Size Indicated paper tray does not contain paper of select-
ed size.

Mismatch: Paper Size and Type Indicated paper tray does not contain paper of select-
ed size and type.

Mismatch: Paper Type Indicated paper tray does not contain paper of select-
ed type.

Near Replacing: Black PCU Prepare the new black photoconductor unit. 

Near Replacing: Develop. Unit K Prepare the new development unit (black). 

Near Replacing: Fusing Unit Prepare the new fusing unit. 

Nearly Full: Waste Toner Waste toner bottle is nearly full.

No Paper: Selected Tray There is no paper in specified tray. 

No Paper: Tray 1 There is no paper in tray 1. 

No Paper: Tray 2 There is no paper in tray 2. 

No Paper: Tray 3 There is no paper in tray 3. 

No Paper: Tray 4 There is no paper in tray 4. 

Not Detected: B2 Lever B2 lever is not correctly set. 

Not Detected: Black Toner Black toner is not correctly set. 

Not Detected: Develop. Unit (K) The development unit (black) is not correctly set. 

Not Detected: Duplex Feed Unit The duplex unit is not correctly set. 

Not Detected: Duplex Unit The duplex feed unit is not correctly set. 

Messages Description
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Not Detected: Finisher Finisher is not correctly set.

Not Detected: Fusing Unit The fusing unit is not correctly set. 

Not Detected: Input Tray The paper feed tray is not correctly set. 

Not Detected: PCU The photoconductor unit is not correctly set.

Not Detected: Tray 1 Tray 1 is not correctly set.

Not Detected: Tray 2 Tray 2 is not correctly set.

Not Detected: Tray 3 Tray 3 is not correctly set.

Not Detected: Tray 4 Tray 4 is not correctly set.

Not Detected: WasteToner Bottle Waste toner bottle is not correctly set.

Not Reached, Data Deleted Unreached job is deleted.

Offline Printer is offline.

Original on Exposure Glass The original remains on the exposure glass.

Operating Thermo-range Error The machine is operating outside the permissible tem-
perature range.

Panel Off Mode The machine is in Panel-Off mode.

Panel Off Mode>>Printing ava. The machine is in Control Panel-Off mode.

Paper in Duplex Unit The paper remains in the duplex unit. 

Paper Misfeed: ADF The paper has jammed in Document Feeder.

Paper Misfeed: Duplex Unit The paper has jammed in the duplex unit. 

Paper Misfeed: Input Tray The paper has jammed in the input tray. 

Paper Misfeed: Internal/Output The paper has jammed inside the machine. 

Print Complete The print was completed. 

Printing... Printing is in progress.

Processing Data is being processed. 

Proxy Address/Port Incorrect The proxy address and port setting is incorrect.

Proxy User/Password Incorrect The proxy user name and password setting is incorrect.

Ready The machine is ready to print.

Renewing Remote Certificate The remote certificate is being renewed.

Replace Cleaning Web It is time to replace the Cleaning Web. 

Replace Develop. Unit It is time to replace the development unit. 

Replace Fusing Unit It is time to replace the fusing unit. 

Replace Transfer Cleaning Unit It is time to replace the transfer cleaning unit. 

Retarding... Printing has stopped momentarily to allow printed 
sheets to dry.

SD Card Authentication failed SD card authentication failed.

Setting Remotely The RDS setting is being processed. 

Messages Description
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Note

❒ For details about UNIX commands, see UNIX Supplement.

❒ Check the error contents that may be printed in the configuration page. For
details about printing a configuration page, see Printer Reference.

Printer configuration

You can check the printer configuration using telnet.

This section explains the checking procedure for input/output tray and printer
language.

• UNIX: Use the "info" command and "rsh", "rcp", “ftp”, and "sftp" parameters. 

• mshell: Use the "info" command. 

❖ Input Tray

Skipped due to Error Skipped the error. 

Storage Complete The storage is complete.

Storage Failed The storage has failed.

Supplies Order Call failed The supply order call has failed. 

Transmission Aborted The transmission was interrupted. 

Transmission Complete The transmission completion was completed. 

Transmission Failed The transmission has failed.

Tray Error: Chaptering The paper feed tray specification error has occurred 
because chaptering as well as the normal paper use 
the same tray for printing.

Tray Error: Duplex Printing Selected paper tray cannot be used for duplex print-
ing.

Unit Left Open: ADF Document feeder is opened.

Waiting for Job Suspension The machine is waiting for Job Suspension.

Warming Up... The machine is warming up.

Item Description

No. ID number of the paper tray

Name Name of the paper tray

PaperSize Size of paper loaded in the paper tray

Status Current status of the paper tray

• Normal: Normal

• NoInputTray: No tray

• PaperEnd: No paper

Messages Description
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❖ Output Tray

❖ Printer Language

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

No. ID number of the output tray

Name Name of the output tray

Status Current status of the output tray

• Normal: Normal

• PaperExist: Paper exist

• OverFlow: Paper is full

• Error: Other errors

Item Description

 No. ID number of the printer language used by the 
printer

 Name Name of the printer language used in the 
printer

Version Version of the printer language
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Understanding the Displayed Information 

This section explains how to read status information returned by the network in-
terface board.

Print Job Information

Use the following command to display print job information:

• UNIX: Use the "info" command and "rsh", "rcp", “ftp”, and "sftp" parameters. 

• mshell: Use the "info" command. 

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

Rank Print job status.

• Active
Printing or preparing for printing.

• Waiting
Waiting to be transferred to the printer.

Owner Print request user name.

Job Print request number.

Files The name of the document.

Total Size The size of the data (spooled).

The default is 0 bytes.
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Print Log Information

This is a record of the most recent jobs printed.

Use the following command to display print log information:

• UNIX: Use the "prnlog" command and "rsh", "rcp", "ftp", and "sftp" parame-
ters. 

• telnet : Use the “prnlog” command.

Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Item Description

ID Print request ID.

User Print request user name.

Page Number of pages printed

Result Print Request Result

Communication Result

• OK
Print was completed normally. However, the print result may 
not be as required due to printer problems.

• NG
Printing was not completed normally.

• Canceled
An "rcp", "rsh", or "lpr" command print request was canceled, 
possibly due to the printing application. Not applicable to the 
"ftp" or "rprinter" command.

Time Time the print requested was received.

Time of print request reception

User ID Printer driver-configured User ID.

Appears when the print request ID is specified.

JobName Name of the document for printing

Appears when the print request ID is specified.
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Configuring the Network Interface Board

Use the following command to display network interface board settings:

• telnet : Use the “show” command.

Item Description

Common

Mode 

Protocol Up/Down Protocol Settings

AppleTalk

IPv4

IPv6

TCP/IP

Netware

SMB

Device Up/Down Device Settings

Parallel

USB

Bluetooth

Ethernet interface

Syslog priority

NVRAM version 

Device name

Comment

Location

Contact

Soft switch

AppleTalk AppleTalk settings

Mode

Net

Object

Type

Zone
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TCP/IP TCP/IP settings

Mode(IPv4)

Mode(IPv6)

ftp

lpr

rsh

diprint 

web 

http

ftpc 

snmp

ipp

autonet

Bonjour

ssl

nrs

rfu

nbt

ssdp

ssh

sftp

IPv4

DHCP

Address

Netmask

Broadcast

Gateway

IPv6

Stateless 

Manual

Gateway

EncapType

Host name

DNS Domain

Item Description
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Access Control Access Control settings

IPv4 X can be set between 1 and 5.

AccessEntry[X]

IPv6

AccessEntry[X] X can be set between 1 and 5.

Time server Time settings

Time Zone

Time server polling time

SYSLOG server Websys settings

Home page URL1 

Home page link name1

Home page URL2 

Home page link name2

Help page URL

Netware

EncapType

RPRINTER number 

Print server name

File server name

Context name

Switch

Mode

NDS/Bindery

Packet negotiation

Login Mode

Print job timeout

Protocol

SAP interval time

NDS Tree Name

Transfer Protocol

Item Description
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SMB SMB settings

Switch

Mode

Directprint

Notification

Workgroup name

Computer name

Comment

 Share name[1] 

 Protocol

IEEE 802.11b IEEE 802.11b settings

Host Name

Communication mode

SSID

Channel range

Channel

TX Rate

Security

WEP Authentication

WEP Encryption key number

WEP Encryptionkeys [X] X can be set between 1 and 5.

WPA Encryption

WPA Authentication

Pre-Shared Key

User name

Domain name

EAP Type

Password

Phase 2 username

Phase 2 Method TTLS

Phase 2 Method PEAP

Server cert

IntermediateCA

Server ID

Item Description
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DNS DNS settings

IPv4

Server[X] X can be set between 1 and 3.

Selected IPv4 DNS Server

IPv6

Server[X] X can be set between 1 and 3.

Domain Name

ether

wlan

DDNS

ether

wlan

WINS WINS settings

ether

Primary WINS

Secondary WINS

wlan

Primary WINS

Secondary WINS

Bluetooth Bluetooth settings

Bluetooth mode Bluetooth connection mode

SSDP SSDP settings

UUID

Profile

TTL

UPnP UPnP settings

URL

Item Description
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Bonjour Bonjour (Redezvous) settings

Computer Name (cname)

Local Hostname (ether)

Local Hostname (wlan)

Location

Priority (diprint)

Priority (lpr)

Priority (ipp)

IP TTL

LinkLocal Route for Multi I/F

SNMP SNMP settings

SNMPv1v2

SNMPv3

protocol

v1Trap

v2Trap

v3Trap

SNMPv1v2 Remote Setting

SNMPv3 Privacy

ssh ssh settings

Compression 

Port

TimeOut

Login TimeOut

AuthFree Authfree settings

IPv4

AuthFreeEntry[X] X can be set between 1 and 5.

IPv6 

AuthFreeEntry[X] X can be set between 1 and 5

Parallel

USB

Item Description
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LPR

lprm check host 

Certificate

Verification

Shell mode Remote maintenance tool mode

Item Description
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Message List

This is a list of messages that appear in the machine's system log. The system log
can be viewed using the "syslog" command.

System Log Information

Use the following command to display the system log information:

• UNIX: Use the "syslog" command and "rsh", "rcp", “ftp”, and "sftp" parame-
ters. 

• telnet : Use the “syslog” command. 

Message Problem and solutions

Access to NetWare server <file server name> 
denied. Either there is no account for this print 
server on the NetWare server or the password 
was incorrect. 

(In the print server mode) Login to the file 
server failed. Make sure that the print server is 
registered on the file server. If a password is 
specified for the print server, deleteit.

account is unavailable:

Same account name be used.

User account is disabled. This could be be-
cause it use the same account name as the ad-
ministrator account.

account is unavailable:

The authentication password is not set up.

User account is disabled. This could be be-
cause the authentication password is not set, 
and only the encryption account is set.

account is unavailable:

encryption is impossible.

Encryption is not possible and account is disa-
bled. This could be because:

• Security option is not installed.

• Encryption password has not been speci-
fied.

add_sess_IPv4: bad trap <IPv4 address>com-
munity <community name>

The IPv4 address (0.0.0.0.) is unavailable when 
the community access type is TRAP. Specify 
the host IPv4 address for the TRAP destina-
tion.

add_sess_IPv6: bad trap <IPv6 address>com-
munity <community name>

The IPv6 address [::] is unavailable when the 
community access type is TRAP. Specify the 
host IPv6 address for the TRAP destination.

add_sess_IPv4: community<community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_IPv6: community <community 
name> already defined.

The same community name already exists. 
Use another community name.

add_sess_IPX: bad trap<IPX address>commu-
nity <community name>

The IPX address (00:00:00:00:00:00) is unavail-
able when the community access type is 
TRAP. Specify the host IPX address for the 
TRAP destination.

add_sess_ipx: community <community-
name> already defined.

The same community name already exists. 
Use another community name.
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Attach FileServer= <file servername> Connection to the file server as the nearest 
server has been established.

Attach to print queue <print queue name> (In the print server mode) Attached to the 
print queue.

authenticating The computer is performing WPA authentica-
tion through the access point.

authentication mode mismatch The authentication modes of the computer and 
access point do not match.

Authentication mode mismatch< SSID > Authentication mode is different to the AP. 
The required SSID is the SSID of the access 
point connected to when in infrastructure 
mode.

btd is disabled. Communication via Bluetooth is unavailable 
because btd is disabled in the security mode.

 Enable the btd in the security mode.

cipher suite mismatch The cipher suite (TKIP/AES/WEP) of the 
computer and that of the access point do not 
match.

centrod is disabled. Communication via parallel connections una-
vailable because centrod is disabled in the se-
curity mode.

Enable centrod in the security mode.

Cannot create service connection (In the remote printer mode) Connection to the 
file server has not been established. The 
number of file server users may have exceeded 
the maximum capacity of the file server.

Cannot find rprinter (<print server 
name>/<printer number>)

The printer with the number displayed on the 
print server does not exist. Make sure that the 
printer number is registered on the print serv-
er.

Change IP address from DHCP Server. The IP address changes when DHCP lease is 
renewed. To always assign the same IP ad-
dress, set a static IP address to the DHCP serv-
er.

Client password rejected The client's password was rejected. Check the 
client password.

Client tls certificate rejected The client's TLS certificate was rejected. Check 
the certificate.

Connected DHCP Server(<DHCP server ad-
dress>).

The IP address was successfully received from 
the DHCP server.

Could not attach to File Server<error number> (In the remote printer mode) Connection to the 
file server has not been established. The file 
server has refused the connection. Check the 
file server configuration.

Message Problem and solutions
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Could not attach to P Server<print server> (In the remote printer mode) Connection to the 
print server has not been established. The 
print server has refused the connection. Check 
the print server configuration.

Current Interface Speed:xxxMbps Speed of the network (10Mbps, 100 Mbps, or 
1Gbps).

Current IP address <currentIP address> Current IPv4 address.

Current IPX address<IPX address> Current IPX address

DHCP lease time expired. DHCP lease time has expired. The printer tries 
to discover the DHCP server again. The IP ad-
dress until now becomes invalid.

DHCP server not found. The DHCP server was not found. Make sure 
that the DHCP is on the network.

dhcpcd start. The DHCPCD service (dhcp client service) has 
started.

dpsd is disabled. Communication via PictBridge is unavailable 
because PictBridge is disabled in the security 
mode. Enable PictBridge in the security mode.

Duplicate IP=<IP address>(from<MAC ad-
dress>).

The same IP address (IPv,or IPv6 address) was 
used. Each IP address (IPv, or IPv6 address) 
must be unique. Check the address of the de-
vice indicated in [MAC address].

Established SPX Connection with PServ-
er,(RPSocket=<socketnumber>, con-
nID=<connection ID>)

(In the remote printer mode) Connection to the 
print server has been established.

exiting The lpd service has ended and the system is 
exiting the process.

Exit pserver (In the print server mode) The print server 
function is disabled because the necessary 
print server settings have not been made.

Frametype =<frame typename> The frame type name is configured to be used 
on NetWare.

httpd start. The httpd service has started.

IEEE 802.11b <communication mode> mode Displays the IEEE 802.11b communication 
mode.

IEEE 802.11b current channel IEEE 802.11b 
current channel 

Displays the IEEE 802.11b channel number.

IEEE 802.11b interface up The IEEE 802.11b link has been established.

IEEE 802.11b interface down The IEEE 802.11b link has been cut.

IEEE 802.11b card removed The IEEE 802.11b card is not installed correct-
ly.

inetd start. The inetd service has started.

Message Problem and solutions
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Interface (interface name): Duplicate IP Ad-
dress (IP address).

The same IP (IPv4 or IPv6) address was used. 
Each IP address must be unique. Check the ad-
dress of the device indicated in [IP address].

< Interface >: Subnet overlap. The same IP address (IPv, orIPv6 address) and 
the subnet mask is used with other device.

IPP cancel-job: permission denied. The printer could not authenticate the name of 
the user attempting to cancel a job.

IPP job canceled. jobid=%d. The spooled job was canceled due to error or 
user request.

LEAP challenge to access point failed LEAP authentication has failed.

LeaseTime=<lease time>(sec), Renew-
Time=<renewtime>(sec).

The resource lease time received from the 
DHCP server is displayed in [lease time] in 
seconds. The renewal time is displayed in [re-
new time] in seconds.

Login to fileserver <file server name> 
(<IPX|IPv4|IPv6>,<NDS|BINDERY>) 

(In the print server mode) Login to the file 
server is in the NDS or BINDERY mode.

Memory allocate error. Data cannot be obtained. 

Disconnect the USB cable, and then connect it.

MIC failure TKIP counter measures started An attack was detected during TKIP operation 
and the computer has taken countermeasures.

MIC failure TKIP counter measures stopped Following attack during TKIP operation, the 
computer has ended attack countermeasures 
after 60 seconds.

Name registration success. WINS Serv-
er=<WINS server address> NetBIOS 
Name=<NetBIOS name> 

Name registration of <NetBIOS Name> to 
<WINS server address> was successful.

Name registration success in Broadcast 
name=<NetBIOS Name> 

Name registration by Broadcast name of <Net-
BIOS Name> was successful.

Name registration failed. name=<NetBIOS 
name> 

Name registration of <NetBIOSName> failed. 
Change to different NetBIOS name. 

nbtd start. The nbtd service has started.

no RADIUS/authentication server A RADIUS server could not be found.

no smart card detected on device No smartcard was detected on the computer 
during GTC authentication.

nprinter start (Netware) (In the remote printer mode) The NetWare 
service has started.

nwstart start. (NetWare) The service for NetWare protocol stack setting 
has started.

Open log file <file name> (In the print server mode)The specified log file 
has been opened.

Print queue <print queue name> cannot be 
serviced by printer 0, <print server name>

(In the print server mode) The print queue 
cannot be established. Make sure that print 
queue exists on the specified file server.

Message Problem and solutions
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Print server <print servername>has no printer. (In the print server mode) The printer is not as-
signed to the print server. Using NWadmin, 
assign the printer, and then restart it. 

print session full No more print jobs can be accepted.

Printer <printer name> has no queue (In the print server mode) The print queue is 
not assigned to the printer. Using NWadmin, 
assign the print queue to the printer, and then 
restart it.

pserver start. (NetWare) (In the print server mode) The NetWare serv-
ice has started.

Required file server (<file servername>) not 
found

The required file server is not found.

received EAP Failure EAP reception failed.

restarted. The lpd service has started.

sap enable, saptype=<SAP type>, sap-
name=<SAP name>

The SAP function has started. The SAP packet 
is issued to advertise the service on the SAP ta-
ble on the NetWare server.

server identity invalid The server ID is disabled. Check the server au-
thentication.

session IPv4 <community name> not defined. The requested community name is not defined.

session IPv6 <community name> not defined. The requested community name is not defined.

session_ipx <community name> not defined. The requested community name is not defined.

server not trusted The status of the RADIUS server indicates the 
server is not trustworthy.

server certificate invalid The server certificate is invalid.

Set context to <NDS contextname> An NDS context name has been set.

shutdown signal received. network service re-
booting...

The network service is rebooting.

smbd start. (NETBIOS) The smbd service has started.

SMTPC: failed to get smtp server ip-address. The SMTP server IP address could not be ob-
tained. This could be because:

• The specified DNS server could not be 
found.

• No connection to the network has been es-
tablished.

• The specified DNS server could not be 
found.

• An incorrect DNS server is specified.

• The specified SMTP server IP address 
could not be found in the DNS server.

Message Problem and solutions
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SMTPC: failed to connect smtp server. timeout. Connection to the SMTP server failed due to 
timeout. This could be because the specified 
SMTP server name is incorrect, or no connec-
tion to the network has been established, or the 
network configuration is incorrect, so there is 
no response from the SMTP server. Check the 
SMTP server name, or the network connection 
and configuration. 

SMTPC: refused connect by smtp server. Connection to the SMTP server is denied. This 
could be because server other than the SMTP 
server has been specified, or the specified 
SMTP server port number is incorrect. Check 
the SMTP server name, port number, or the 
SMTP server port number.

SMTPC: no smtp server. connection close. Connection to the SMTP server failed due to 
no response from SMTP. This could be be-
cause a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the SMTP 
server name, port number, or the SMTP server 
port number.

SMTPC: failed to connect smtp server. Connection to the SMTP server failed. This 
could be because no connection to the network 
has been established,or the network configu-
ration is incorrect, so there is no response from 
the SMTP server, or the specified SMTP server 
name is incorrect, or the specified SMTP server 
IP address could not be found in the DNS serv-
er, or a server other than the SMTP server has 
been specified, or the specified SMTP server 
port number is incorrect. Check the DNS Serv-
er's IP address and SMTP server's IP address, 
or the SMTP server name and SMTP port 
number, or the SMTP server's SMTP port 
number, or the network connection and con-
figuration.

SMTPC: username or password wasn’t cor-
rect. [response code] (information)

Connection to the SMTP server failed, because 
the specified SMTP user name is incorrect, or 
the specified SMTP password is incorrect. 
Check the SMTP user name and password.

Snmp over IPv4 is ready Communication over IPv4 with snmp is avail-
able.

Snmp over IPv6 is ready. Communication over IPv6 with snmp is avail-
able.

Snmp over ipx is ready. Communication over IPX with snmp is availa-
ble.

snmpd start. The snmpd service has started.

started. The direct print service has started.

Message Problem and solutions
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Note

❒ For details about UNIX commands and parameters, see UNIX Supplement.

Started. The bonjour (rendezvous) function is enabled.

success but invalid key The computer received a message reporting 
successful EAP authentication, but the EAPOL 
key is invalid.

terminated. The bonjour (rendezvous) function is disabled.

The print server received error <error 
number> during attempt to log in to the net-
work. Access to the network was denied. Ver-
ify that the print server name and password 
are correct. 

Login to the file server failed. The print server 
is not registered or a password is specified. 
Register the print server without specifying a 
password.

trap account is unavailable. v3Trap cannot be sent. This could be because 
the Trap destination account is different from 
the account specified by the printer.

unauthenticated Authentication between the computer and ac-
cess point failed.

usbd is disable. Plug and Play function and printing is disa-
bled because usbd is disabled in the security 
mode.

Enable usbd in the security mode.

WINS name registration: No response to serv-
er<WINS server address>

There was no response from the WINS server. 
Check the correct WINS server address is en-
tered. Alternatively, check the WINS server is 
functioning properly. 

WINS wrong scopeID=<Scope ID> An invalid scope ID was used. Use a valid 
scope ID.

unauthenticated WPA authentication failed. Check the WPA 
configuration.

WPA supplicant unbound WPA authentication has started.

connecting WPA is connecting to authenticator.

no WPA information element in probe re-
sponse,rescanning

WPA probe response does not have IE.

authenticated WPA authentication was successful.

wpa success key received WPA key reception was successful.

waiting for keys Waiting for WPA key.

WPA supplicant started wpasupd has started.

stopped wpasupd has ended.
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3. Special Operations under
Windows

Printing Files Directly from Windows

You can print files directly using Windows commands. For example, you can
print PostScript files for PostScript 3.

❖ Windows 95/98/Me
You can print files directly using ftp or sftp command.

❖ Windows 2000/XP, Windows Server 2003, Windows NT 4.0
You can print files directly using lpr, rcp ftp or sftp command.

Setup

Follow the procedure below to make network environment settings.

A Enable TCP/IP with the control panel, and then set up the printer’s network
environment about TCP/IP including IP addresses.

TCP/IP of the printer is set as default.

B Install a TCP/IP in Windows to set up the network environment.

Consult the network administrator for the local setting information.

C To print under Windows 2000/XP, Windows Server 2003, or Windows NT
4.0, install “Printing service for UNIX” as the network application. To print
under Windows NT 4.0, install “Microsoft TCP/IP printing” as the network
application.

Reference

p.124 “Using DHCP”
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Using a Host Name Instead of an IPv4 Address

When a host name is defined, you can specify a printer by host name instead of
IP address. The host names vary depending on the network environment.

When using DNS

Use the host name set to the data file on the DNS server.

When setting the IPv4 address of a printer using DHCP

Use the printer name on the configuration page as the host name.

Note

❒ For details about printing a configuration page, see General Settings Guide.

In other cases

Add the IP address and host name of the network printer to the hosts file on the
computer used for printing. Methods of addition vary depending on operating
systems.

Windows 95/98/Me

A Copy \WINDOWS\HOSTS.SAM to the same directory and name it
“HOSTS” with no extension.

B Open the "\WINDOWS\HOSTS" file created using memo pad files, for in-
stance.

C Add an IP address and host name to the hosts file using the following for-
mat:

192.168.15.16  host  # NP

"192.168.15.16" is the IP address, "host" is the printer's host name, and "#NP"
is replaced by comments. Insert a space or tab between "192.168.15.16" and
"host", between "host" and "#NP" respectively, using one line for this format.

D Save the file.
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Windows 2000/XP, Windows Server 2003, Windows NT 4.0

A Open the hosts file using memo pad files, for instance.

The hosts file is in the following folder:

\WINNT\SYSTEM32\DRIVERS\ETC\HOSTS

"\WINNT" is the directory of the installation destination for Windows
2000/XP, Windows Server 2003, and Windows NT 4.0.

B Add an IPv4 or IPv6address and host name to the hosts file using the fol-
lowing format:

192.168.15.16  host  # NP

"192.168.15.16" is the IPv4 address, "host" is the printer's host name, and
"#NP" is replaced by comments. Insert a space or tab between "192.168.15.16"
and "host", between "host" and "#NP" respectively, using one line for this for-
mat.

2001:DB::100 host # NP

 "2001:DB::100" is the IPv6 address, "host" is the printer's host name, and
"#NP" is replaced by comments. Insert a space or tab between "2001:DB::100"
and "host", between "host" and "#NP" respectively, using one line for this for-
mat.

C Save the file.

Note

❒ When using a host name under Windows Server 2003 with IPv6 protocol,
perform host name resolution using an external DNS server. The host file
cannot be used.

Printing Commands

The following explains printing operations using the “lpr”, “rcp”, and “ftp”
commands.

Enter commands using the command prompt window. The location of the com-
mand prompts varies depending on operating systems:

• Windows 95/98
 [Start] - [Programs] - [MS-DOS Prompt] 

• Windows Me
 [Start] - [Programs] - [Accessories] - [MS-DOS Prompt] 

• Windows 2000
 [Start] - [Programs] - [Accessories] - [Command Prompt] 

• Windows XP, Windows Server 2003
 [Start] - [All Programs] - [Accessories] - [Command Prompt] 

• Windows NT 4.0
 [Start] - [Programs] - [Command Prompt] 
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Note

❒ Match the data format of the file to be printed with the emulation mode of the
printer.

❒ If the message "print requests full" appears, no print jobs can be accepted. Try
again when sessions end. For each command, the amount of possible sessions
is indicated as follows:

• lpr: 5

• rcp, rsh: 5

• ftp: 3

• sftp: 3

❒ Enter the file name in a format including the path from the directory execut-
ing commands.

❒ The “option” specified in a command is an intrinsic printer option and its syn-
tax is similar to printing from UNIX. For details, see UNIX Supplement.

lpr

❖ When specifying a printer by IP address

c:> lpr -Sprinter's IP address [-Poption] [-ol] \pass name\file
name

❖ When using a host name instead of an IP address

c:> lpr -Sprinter's host name [-Poption] [-ol] \pass name\file
name
When printing a binary file, add the "-ol" option (lowercase O, and lowercase L).

When using a printer with the host name "host" to print a PostScript file named
"file 1" located in the "C:\PRINT" directory, the command line is as follows:

c:> lpr -Shost -Pfiletype=RPS -ol C:\PRINT\file1

rcp

First, register the printer's host name in the hosts file.

c:> rcp [-b] \pass name\file name [pass name\file name...]
printer's host name:[option]

Note

❒ In file names, "*" and "?" can be used as wild cards.

❒ When printing a binary file, add the “-b” option.

When using a printer with the host name "host" to print a PostScript file named "file
1" or "file 2" located in the "C:\PRINT" directory, the command line is as follows:

c:> rcp -b C:\PRINT\file1 C:\PRINT\file2 host:filetype=RPS

Reference

p.116 “Using a Host Name Instead of an IPv4 Address”
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ftp/sftp

Use the "put" or "mput" command according to the number of files to be printed.

❖ When one file is printed

ftp> put \pass name\file name [option]

❖ When multiple files are printed

ftp> mput \pass name\file name [\pass name\file name...]
[option]

Follow the procedure below to print using the "ftp" command.

A Formulate the printer's IP address or the host name of the hosts file printer
as an argument and use the "ftp" or “sftp” command.

% ftp printer's IP address

B Enter the user name and password, and then press the {# Enter} key.

For details about the user name and password, consult your network admin-
istrator.

User:
Password:

When user authentication is set, enter a login user name and password.

CWhen printing a binary file, set the file mode to binary.

ftp> bin

When printing a binary file in ASCII mode, print may not come out correctly.

D Specify files to be printed.

The following shows the examples of printing a PostScript file named "file 1"
in the "C:\PRINT" directory and printing file 1 and file 2.

ftp> put C:\PRINT\file1 filetype=RPS
ftp> mput C:\PRINT\file1 C:\PRINT\file2

E Quit ftp.

ftp> bye

Note

❒ “=”, “,”, “_”, and “;”cannot be used for filenames. File names will be read
as option strings.

❒ For “mput” command, option can not be defined.

❒ For “mput” command, “*” and “?” can be used as wild cards in file names.

❒ When printing a binary file in ASCII mode, print may not come out cor-
rectly.
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4. Appendix

When Using Windows Terminal Service / 
MetaFrame

The following explains how to use Windows Terminal Service and Maintenance.

Operating Environment

The following operating systems and MetaFrame versions are supported.

❖ Windows NT Server 4.0 Terminal Server Edition

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4

• MetaFrame XP 1.0 SP1 / SP2 / FR1

❖ Windows 2000 Server / Advanced Server

• MetaFrame 1.8 SP3 / FR1+SP3 / SP4

• MetaFrame XP 1.0 SP1 / SP2 / SP3 / FR1 / FR2 / FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

❖ Windows 2003 Server

• MetaFrame XP 1.0 FR3

• MetaFrame Presentation Server 3.0

• Citrix Presentation Server 4.0

Supported Printer Drivers

❖ When Windows Terminal Service is operating

• PCL drivers

• PostScript 3

• RPCS drivers

Note

❒ Some RPCS printer driver functions do not work if Windows Terminal Serv-
ice is installed.



Appendix

122

4

Limitations

The following limitations apply to the Windows Terminal Service environment.

These limitations are built in Windows Terminal Service or MetaFrame.

❖ Windows Terminal Service
In the Windows Terminal Service environment, some of the printer driver’s
functions is unavailable. In an environment where Windows Terminal Serv-
ice is installed, some of the printer driver’s functions is unavailable, even if
any function of Windows Terminal Service is not used. When you install
SmartDeviceMonitor for Client in an environment where the Terminal Serv-
ice is running on a Windows NT Server 4.0 Terminal Server Edition or the
Windows 2000 Server family computer, be sure to install it using the install
mode. The following are the two methods of installation using the install
mode:

A Use [Add/Remove Programs] in [Control Panel] to install SmartDeviceMonitor
for Client.

B Enter the following command in the MS-DOS command prompt:
To quit the install mode, enter the following command in the MS-DOS com-
mand prompt.

❖ MetaFrame's [Auto-creating client printers] 
Using [Auto-creating client printers] can select a logical printer created by copy-
ing the client's local printer data to the MetaFrame server. We strongly recom-
mend testing this function in your network environment before using it for
your work.

• The settings for optional equipment will not be stored in the server after
the equipment is disconnected. The settings for optional equipment will be
restored to its defaults each time the client computer logs on to the server.

• When printing a large number of bitmap images or using the server in a
WAN environment over dial-up lines such as ISDN, printing may not be
possible or errors may occur, depending on data transfer rates.

• When using MetaFrame XP 1.0 or higher versions, we recommend making
settings in [Client Printer bandwidth] under [Citrix Management Console] accord-
ing to the environment.

• If a print error occurs on the server and the print job or a printer created in
[Auto-creating client printers] cannot be deleted, we recommend the following:

• MetaFrame 1.8 SP3, MetaFrame XP 1.0 SP1/FR1
Make settings in [Delete unfinished print jobs] in the registry. For details,
see the Readme file provided with MetaFrame.

• MetaFrame XP 1.0 FR2
Make settings in [Delete pending print jobs at logout] under [Printer Proper-
ties Management] of Citrix Management Console.
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❖ MetaFrame's [Printer driver replication] 
Using [Printer driver replication] can distribute printer drivers across all servers
in a server farm. We strongly recommend testing this function in your net-
work environment before using it for your work.

• If the printer drivers are not properly copied, install them directly onto
each server.
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Using DHCP

You can use the printer in a DHCP environment. You can also register the print-
er NetBIOS name on a WINS server when it is running.

Note

❒ Printers that register the printer NetBIOS name on a WINS server must be
configured for the WINS server.

❒ Supported DHCP servers are Microsoft DHCP Server included with Win-
dows 2000 Server, Windows Server 2003, and Windows NT 4.0, and the
DHCP server included with NetWare and UNIX.

❒ If you do not use the WINS server, reserve the printer's IP address in the
DHCP server so the same IP address is assigned every time.

❒ To use the WINS server, change the WINS server setting to “active” using the
control panel.

❒ Using the WINS server, you can configure the host name via the remote net-
work printer port.

❒ DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via ISDN, it will result in increased line charges. This is because your
computer connects to the ISDN line whenever a packet is transferred from the
printer.

❒ If there is more than one DHCP server, use the same setting for all servers.
The machine operates using data from the DHCP server that responds first.

Using AutoNet

If the printer IPv4 address is not automatically assigned by the DHCP server, a
temporary IP address starting with 169.254 and not used on the network can be
automatically selected by the printer.

Note

❒ The IP address assigned by the DHCP server is given priority over that select-
ed by AutoNet.

❒ You can confirm the current IPv4 address on the configuration page. For
more information about the configuration page, see General Settings Guide.

❒ When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

❒ The machine cannot communicate with devices that do not have the AutoNet
function. However, this machine can communicate with Macintosh comput-
ers running Mac OS X 10.2.3. or higher.
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Precautions

Please pay attention to the following when using the network interface board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial-Up Router to a Network

When using NetWare (file server)

If the NetWare file server and printer are on opposite sides of a router, packets
are sent back and forth continuously, possibly incurring communications charg-
es. Because packet transmission is a feature of NetWare, you need to change the
configuration of the router. If the network you are using does not allow you to
configure the router, configure the machine instead.

❖ Configuring the router
Filter packets so they do not pass over the dial-up router.

Note

❒ The MAC address of the filtering printer is printed on the printer configu-
ration page. For more information about printing a configuration page, see
Printer Reference.

❒ For more information about configuring the printer if the router cannot be
configured, see the following instructions.

Configuring the printer with NetWare

A Following the setup method described earlier in this manual, configure the
file server.

B Set the frame type for NetWare environment.

Reference

For more information about selecting a frame type, see the General Set-
tings Guide.

Configuring the printer without NetWare

AWhen not printing, the network interface board sends packets over the net-
work. Set NetWare to “inactive”.

Reference

For more information about selecting a protocol, see General Settings
Guide.



Appendix

126

4

When Using Network Utility

If the machine is connected to a network, observe the following points when set-
ting up the machine or changing settings:

For more details, see the operating instructions and Help for ScanRouter V2 Pro-
fessional and DeskTopBinder Lite/Professional.

❖ When a dial-up router is connected in a network environment
The settings for the delivery server to be connected must be made appropri-
ately for the machine with ScanRouter V2 Professional, Auto Document Link,
or DeskTopBinder Lite/Professional. In addition, set up connected devices
using the I/O settings of ScanRouter V2 Administration Utility.
If the network environment changes, make the necessary changes for the de-
livery server using the machine, the administration utility of client comput-
ers, Auto Document Link, and DeskTopBinder Lite/Professional. Also, set
the correct information for the connected devices using the I/O settings of
ScanRouter V2 Administration Utility.

Important

❒ If the machine is set up to connect to the delivery server via a dial-up rout-
er, the router will dial and go online whenever a connection to the delivery
server is made. Telephone charges may be incurred.

❖ When connected to a computer that uses dial-up access

• Do not install ScanRouter V2 Professional on a computer which uses dial-
up access.

• When using ScanRouter V2 Professional, DeskTopBinder Lite/Profession-
al, Auto Document Link, or a TWAIN driver on a computer with dial-up
access, a dial-up connection may be performed when connecting to the de-
livery server and other equipment, depending on the setup. If the compu-
ter is set up to connect to the Internet automatically, the confirmation
dialog box will not appear, and telephone charges may be incurred with-
out your being aware of it. To prevent unnecessary connections, the com-
puter should be set up so the confirmation dialog box always appears
before establishing a connection. Do not make unnecessary connections
when using the above listed software.
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NetWare Printing

Form feed

You should not configure form feed on NetWare. Form feed is controlled by the
printer driver on Windows. If NetWare form feed is configured, the printer
might not work properly. If you want to change form feed settings, always con-
figure them using Windows.

• Under Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

• Under Windows 2000/XP and Windows Server 2003, clear the [Form feed]
check box on the [NetWare Settings] tab in the printer properties dialog box.

• Under Windows NT 4.0, clear the [Form feed] check box on the [NetWare Set-
tings] tab in the printer properties dialog box.

Banner page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it using Windows.

• Under Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

• Under Windows 2000/XP and Windows Server 2003, clear the [Enable banner]
check box on the [NetWare Settings] tab in the printer properties dialog box.

• Under Windows NT 4.0, clear the [Enable banner] check box on the [NetWare
Settings] tab in the printer properties dialog box.

Printing after resetting the machine

After resetting the remote printer, the connection from the print server will be
cut off for about 30-40 seconds before re-connecting. Depending on the NetWare
specification, print jobs may be accepted, but they will not be printed during this
interval.

When using the machine as a remote printer, wait about two minutes after reset-
ting before attempting to print.
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When the optional IEEE 802.11b interface unit Is Installed

When using the wireless LAN interface on the network, note the following:

❖ When moving the machine
Detach the antennas when relocating the machine locally.
After moving the machine, reattach the antennas, ensuring that: 

• The antennas are positioned clear of obstacles.

• There is 40 to 60 mm between the antennas, so that they do not touch.

• The exposure glass cover and the Auto Document Feeder (ADF) do not
knock the antennas.

❖ If the network area provides poor radio environment
Where radio wave conditions are bad, the network may not function due to
interrupted or failed connections. When checking the wireless LAN signal
and the access point, follow the procedure below to improve the situation:

• Position the access point nearer to the machine.

• Clear the space between access point and machine of obstructions.

• Move radio wave generating appliances, such as microwaves, away from
the machine and access point.

Note

❒ For information about how to check radio wave status, see the General Set-
tings Guide.

❒ For more information about access point radio wave conditions, refer to the
access point manual.
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Information about Installed Applications

RSA® BSAFE

• This product includes RSA® BSAFE cryptographic or security protocol soft-
ware from RSA Security Inc.

• RSA is a registered trademark and BSAFE is a registered trademark of RSA
Security Inc. in the United States and/or other countries.

• RSA Security Inc. All rights reserved.
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Specifications

Interface 100BASE-TX, 10BASE-T, IEEE 802.11b

Frame type EthernetII, IEEE 802.2, IEEE 802.3, SNAP

Printer (LAN-Fax) IPv4

LPR

RSH

RCP

DIPRINT

FTP

IPP 

IPX/SPX (NetWare)

AppleTalk

SMB

Internet Fax IPv4

SMTP

POP3

IMAP4

Network Scanner IPv4

RSH

FTP

SMTP

POP3

SMB

NCP

Management Function IPv4

RSH

RCP

FTP

SNMP

HTTP

TELNET (mshell)

NBT

DHCP

DNS

LDAP

SNMP v1/v2 MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB

SNMP v3 MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB, SNMP-
FRAMEWORK-MIB, SNMP-TARGET-MIB, SNMP-NOTIFICA-
TION-MIB, SNMP-USER-BASED-SM-MIB, SNMP-VIEW-
BASED-ACM-MIB
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To use IPP and SMB, use the SmartDeviceMonitor for Client port.

To use IPP under Windows XP/Vista, Windows Server 2003, use the Standard
IPP port. To use IPP under Windows 98, Windows 2000, Windows NT, use
SmartDeviceMonitor for Client.

Appletalk can be used when the PostScript 3 module is installed.
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Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS , and TrueType are trademarks of Apple Inc, regis-
tered in the United States and other countries.

BonjourTM is a trademark of Apple Inc.

Netscape and Netscape Navigator are registered trademarks of Netscape Communications Corporation.

Novell, NetWare, NDS and NDPS are registered trademarks of Novell, Inc.

PostScript® and Acrobat® are registered trademarks of Adobe Systems, Incorporated.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

Citrix® and MetaFrame® are registered trademarks of Citrix Systems, Inc.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

UPnP is a trademark of the UPnP Implementers Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

• The product name of Windows® 95 is Microsoft® Windows 95.

• The product name of Windows® 98 is Microsoft® Windows 98.

• The product name of Windows® Me is Microsoft® Windows Millennium Edition (Windows Me).

• The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional

• The product names of Windows Vista are as follows:

Microsoft® Windows VistaTM Ultimate

Microsoft® Windows VistaTM Enterprise

Microsoft® Windows VistaTM Business

Microsoft® Windows VistaTM Home Premium

Microsoft® Windows VistaTM Home Basic

• The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

Microsoft® Windows Server® 2003 Web Edition

• The product names of Windows NT 4.0 are as follows:

Microsoft® Windows NT® Workstation 4.0

Microsoft® Windows NT® Server 4.0

RSA Data Security, Inc. MD5 Message-Digest Algorithm

Copyright© 1991-2, RSA Data Security, Inc. Created 1991. All rights reserved.

License to copy and use this software is granted provided that it is identified as the “RSA Data Security,
Inc. MD5 Message-Digest Algorithm” in all material mentioning or referencing this software or this function.

License is also granted to make and use derivative works provided that such works are identified as
“derived from the RSA Data Security, Inc. MD5 Message-Digest Algorithm” in all material mentioning
or referencing the derived work.

RSA Data Security, Inc. makes no representations concerning either the merchantability of this soft-
ware or the suitability of this software for any particular purpose. It is provided “as is” without express
or implied warranty of any kind.

These notices must be retained in any copies of any part of this documentation and/or software.

Copyright © 2007
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